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Важная для пользователя информация
Так как существует множество возможностей использования продуктов, описанных в
этой публикации, лица, ответственные за применение и использование данного
оборудования управления, должны убедиться в том, что были выполнены все
необходимые действия для обеспечения того, что каждое применение и
использование удовлетворяет всем требованиям функционирования и безопасности,
включая все применимые законы, положения, кодексы и стандарты.

Иллюстрации, диаграммы, примеры программ и схем, показанные в этом руководстве,
предназначены исключительно для демонстрационных целей. Так как существует
множество отличий и требований, связанных с любой конкретной инсталляцией, Allen-
Bradley не берет на себя ответственность или обязательство (включая обязательство
интеллектуальной собственности) по фактическому использованию, основанному на
примерах, показанных в этой публикации.

Публикация Allen-Bradley SGI-1.1 «Указания по безопасности при применении,
инсталляции и обслуживании твердотельного элемента управления» (которую вы
можете получить в вашем местном офисе Allen-Bradley) описывает некоторые важные
различия между твердотельным оборудованием и электромеханическими
устройствами, которые следует принимать во внимание при применении таких
продуктов, как те, которые описаны в этой публикации.

Полное или частичное воспроизведение содержимого этой защищенной законом об
авторском праве публикации без письменного разрешения Allen-Bradley Company, Inc.
воспрещено.

На всем протяжении этого руководства мы используем примечания, осведомляющие
вас о соображениях безопасности:

ВНИМАНИЕ: Определяет информацию о действиях и обстоятельствах,
которые могут привести к травме или смерти персонала, ухудшению
свойств или экономическим потерям.

Положения «Внимание» помогают вам:

• определить опасность

• избежать опасности

• осознать последствия

ВАЖНО: Определяет информацию, критичную для успешного
применения и понимания продукта.

PanelBuilder, PanelView 550, PanelView 600, PanelView 900, PanelView 1400, SLC, SLC 500, SLC 5/01, SLC 5/02,
SLC 5/03, SLC 5/04, Data Highway Plus – торговые знаки Allen-Bradley Company, Inc.

PLC и PLC-5 – зарегистрированные торговые знаки Allen-Bradley Company, Inc.

RSLinx и INTERCHANGE – торговые знаки Rockwell Software Inc.

Microsoft, Windows и MS-DOS – зарегистрированные торговые знаки, а Windows NT – торговый знак
Microsoft Corporation.
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Предисловие
Приветствуем вас с началом работы с PanelBuilder™ Software. Чтобы помочь вам начать
работу, в этом руководстве предоставлены некоторые основы использования этого
программного обеспечения и пример приложения. Оно проведет вас по всем этапам,
которые требуются для создания, загрузки и запуска примера приложения на
терминалах Remote I/O, DH-485 или DH+ PanelView™.

Это руководство предназначено для использования в качестве введения. Для
получения дополнительной информации об особенностях программного обеспечения
и о том, как выполнять конкретные задачи, обращайтесь к руководству пользователя
PanelBuilder Software.

PanelBuilder запускается в среде Microsoft® Windows®. Вы должны быть знакомы с
основными операциями в этой среде; такими как использование мыши, выбор команд
и работа с окнами приложения и диалоговыми окнами.

Содержание этого руководства

• Предисловие
Обзор этого руководства и что вам требуется для создания, загрузки и запуска
примера приложения.

• Глава 1 – Основы PanelBuilder
Дает краткий обзор PanelBuilder Software.

• Глава 2 – Начальная настройка системы
Описывает настройку системных компонентов и то, как загрузить требуемую
программу релейно-контактной логики в контроллер PLC или SLC.

• Глава 3 – Обзор примера приложения
Предоставляет описание примера приложения и его функции.

• Глава 4 – Создание примера приложения
Предоставляет поэтапные инструкции по созданию примера приложения.

• Глава 5 – Настройка терминала PanelView
Показывает, как настроить параметры связи выполнения и опции включения
терминала PanelView и контроллера.

• Глава 6 – Ввод тегов приложения
Показывает, как использовать Tag Editor для ввода тегов для приложения.

• Глава 7 – Проверка и загрузка приложения
Показывает, как загрузить пример приложения на терминал PanelView.

• Глава 8 – Запуск приложения
Показывает, как запустить приложение на терминале PanelView.
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Соглашения

В этом руководстве используются следующие соглашения:

• Термин «PanelBuilder» используется вместо «PanelBuilder Configuration Software».

• Термин «Терминал» используется вместо «PanelView Operator Terminal».

• Термин «Windows» используется вместо «Microsoft Windows» версии 3.1 (или
более поздней) или «Windows 95».

• Клавиши на клавиатуре обозначаются мелкими прописными буквами. Например,
клавиша Ctrl в тексте обозначается как Ctrl, клавиша Alt – как Alt и так далее.

• Клавиатурные комбинации обозначаются знаком «+». Например, Alt+F4 означает,
что вы должны удерживать клавишу Alt при нажатии F4.

• Всем алгоритмам предшествует текст, набранный полужирным шрифтом:

Для открытия файла приложения:

• Сплошная правая стрелка на левом поле указывает на совет или указание.

Точка закрепления – это манипулятор, противоположный выбранному вами
манипулятору. Точка закрепления не перемещается при масштабировании объектов.

Другие публикации

В следующей таблице перечислены другие публикации, связанные с PanelBuilder
Software и с операторными терминалами PanelView.

èèöàêèëáóïåèíàâçàÍ èèöàêèëáóïðåìîÍ

ÿëåòàâîçüëîïîâòñäîâîêóÐ
erawtfoSredliuBlenaP

0.6-1172

ÿëåòàâîçüëîïîâòñäîâîêóÐ
weiVlenaPàëàíèìðåò

1.6-1172

àíâîëéàôè÷àäåðåïàòèëèòÓ
weiVlenaPëàíèìðåò

508-1172

Для получения информации о вашем контроллере PLC или SLC, Advanced Programming
Software (пакет программирования для SLC-500) или 6200 Series Programming Software
(пакет программирования для PLC-5) обращайтесь к соответствующим руководствам.

Для получения информации о операциях в операционной системе обращайтесь к
руководству пользователя Windows.

Примечание переводчика

В настоящее время для SLC-500 рекомендуется пакет программирования RSLogix500, для PLC-5 – RSLogix5.
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Что вам требуется

В этом разделе перечислены элементы, требующиеся для создания, загрузки и запуска
примера приложения на терминале PanelView с использованием любой из
перечисленных связей:

• Remote I/O

• DH-485

• DH+

Персональный компьютер

Минимальные системные требования для инсталляции и запуска PanelBuilder Software
на персональном компьютере таковы:

• Персональный компьютер с 386 или лучшим процессором

• Операционная система MS-DOS® версии 5.0 или более поздняя

• Windows® 3.1 или более поздняя (Windows for Workgroups 3.11 или более
поздняя), Windows 95 или Windows NT 4.0.

• 500 Кб свободной обычной (conventional) памяти

• не менее 40 Мб доступного пространства на жестком диске

• VGA или другой дисплей с высоким разрешением, поддерживаемый Windows

• Мышь или другое аналогичное устройство Windows.

PanelBuilder Software

PanelBuilder Software (номер по каталогу 2711-ND3) требуется для создания на
компьютере приложений для терминалов PanelView.

Инсталлируйте PanelBuilder Software, как описано в главе 2 руководства PanelBuilder
Software.
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Операторный терминал PanelView

Пример приложения функционирует со всеми терминалами PanelView.

Различия заключаются в:

• типе дисплея (монохромный или цветной)

• вводе оператором (сенсорный экран или клавиатура)

• портах связи (Remote I/O, DH-485, RS-232, DH+)

Кабели для загрузки/выгрузки

Версии Remote I/O, RS-232 или DH+ терминалов PanelView

Эти терминалы PanelView требуют один из следующих кабелей для загрузки
приложений с использованием подсоединений RS-232:

• Номер по каталогу 2711-NC13

• Номер по каталогу 2711-NC14

• Номер по каталогу 2706-NC13

Эти кабели отличаются только длиной.

Версии DH-485 терминалов PanelView

Версии DH-485 терминалов PanelView требуют следующие элементы для загрузки
приложений:

• Интерфейсный преобразователь персонального компьютера (номер по каталогу
1747-PIC)

• Кабель связей (номер по каталогу 1747-C10, -C11, -C20)

Интерфейсный преобразователь персонального компьютера получает питание от
контроллера SLC. Загрузка приложения на терминал без подсоединенного SLC требует
источника питания (номер по каталогу 1747-NP1) или включенного Link Coupler
(номер по каталогу 1747-AIC).

Кабель связи

Кабель связи требуется для подсоединения терминала PanelView к контроллеру PLC
или SLC.

Версии Remote I/O терминалов PanelView

Версии Remote I/O терминалов PanelView подсоединяются к контроллеру PLC с
использованием кабеля Remote I/O (номер по каталогу 1770-CD), который
соответствует кабелю Belden 9463.



Предисловие

П-5

Версии DH-485 терминалов PanelView

Версии DH-485 терминалов PanelView требуют один из следующих кабелей:

• Номер по каталогу 1747-C10

• Номер по каталогу 1747-C11

• Номер по каталогу 1747-C20

Эти кабели отличаются только длиной.

Версии RS-232 терминалов PanelView

Версии терминалов RS-232 используют один и тот же кабель для загрузки и связи.

• Номер по каталогу 2711-NC13

• Номер по каталогу 2711-NC14

• Номер по каталогу 2706-NC13

Версии DH+ терминалов PanelView

Версии DH+ терминалов PanelView подсоединяются к связи DH+ с использованием
кабеля Belden 9463 (номер по каталогу 1770-CD).

Контроллер PLC или SLC

Версии Remote I/O терминалов PanelView

Версии Remote I/O терминалов PanelView функционируют с контроллером PLC 5 или
SLC (со сканнером 1747-SN). Пример приложения использует контроллер PLC 5/25.

Версии DH-485 терминалов PanelView

Версии DH-485 терминалов PanelView функционируют как со стационарными (fixed),
так и с модульными (modular) контроллерами SLC 500.

Версии RS-232 терминалов PanelView

Версии RS-232 терминалов PanelView требуют контроллер SLC 5/03 или 5/04.

Версии DH+ терминалов PanelView

Версии DH+ терминалов PanelView функционируют как с контроллером PLC 5, так и с
контроллером SLC. Пример приложения использует контроллер PLC 5/25.
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Приложение и программа релейно-контактной логики

Инсталляционный диск PanelBuilder содержит:

• Приложение Getting Started (файлы .PBA) для каждого терминала PanelView.

• Требуемую релейно-контактную логику для запуска приложения, включающую:

– файлы релейно-контактной логики SLC для приложения DH-485/DH+

– файлы релейно-контактной логики PLC для приложения Remote I/O

– файлы релейно-контактной логики PLC для приложения DH+

Эти файлы сохраняются на вашем компьютере следующем образом:

Приложение DH-485 или DH+ C:\AB\PBWIN\GS\5BV2485.PBA

5KV2485.PBA

6BV2485.PBA

6KV2485.PBA

9CKV2485.PBA

9CTV2485.PBA

9MKV2485.PBA

9MTV2485.PBA

10KC_485.PBA

10KG_485.PBA

10TC_485.PBA

10TG_485.PBA

14MKV2485.PBA

14MTV2485.PBA

Файлы релейно-контактной логики SLC C:\AB\SLC500\GS\GETSTRTD.AC$

GETSTRTD.ACH

GETSTRTD.B0$

GETSTRTD.B1$

GETSTRTD.B2$

GETSTRTD.IX$

GETSTRTD.LX$

GETSTRTD.NAM

GETSTRTD.OP$

GETSTRTD.PC$

GETSTRTD.XD$

GETSTRTD.XO$

Приложение Remote I/O C:\AB\PBWIN\SG\5BV2RIO.PBA

5KV2RIO.PBA

6BV2RIO.PBA
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Файлы релейно-контактной логики PLC (RIO) C:\AB\PLC5\GS\GSRIO.AC$

GSRIO.AF5

GSRIO.B0$

GSRIO.B1$

GSRIO.D1$

GSRIO.IX$

GSRIO.LX$

GSRIO.OP$

GSRIO.P1$

GSRIO.PC$

GSRIO.TTL

Файлы релейно-контактной логики PLC (DH+) C:\AB\PLC5\GS\GSDHP.AC$

GSDHP.AF5

GSDHP.B0$

GSDHP.B1$

GSDHP.D1$

GSDHP.IX$

GSDHP.LX$

GSDHP.OP$

GSDHP.P1$

GSDHP.PC$
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1 Основы PanelBuilder

Задачи главы

Эта глава охватывает основы использования PanelBuilder Software.
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èêâàðïñåèíå÷óëîÏ 9-1

Среда Windows

PanelBuilder запускается в среде Microsoft Windows. Вы должны быть знакомы с
операциями в этой среде. Это значит, что вы должны знать, как использовать мышь,
выбирать команды меню и работать с окнами приложения и диалоговыми окнами.

Далее приведены основные термины по использованию мыши:
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Далее приведены основные термины по использованию клавиатуры:
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Окна PanelBuilder

Каждый раз при запуске вами PanelBuilder, открывается окно PanelBuilder. Здесь вы
создаете приложение. Элементы окна описаны ниже.

Меню управления Заголовок
Кнопка свертывания

Кнопка максимального окна
Кнопка закрытия

Строка меню

Панель инструментов
Панель форматирования *

Рамка

Указатель мыши

Строка статуса

Команда

Масштабирование
окна
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Окно файла приложения

Когда вы открываете приложение, открывается окно файла приложения, в котором
перечисляются с номером и именем все экраны в приложении.

Меню управления

Окно Application File

Кнопка закрытия

Кнопка максимального окна
Кнопка свертывания
Заголовок

Рамка

Масштабирование окна

Окно экрана приложения

Каждый экран приложения напоминает терминал PanelView (сенсорный,
клавиатурный, или клавиатурный и сенсорный), для которого вы создаете
приложение. Объекты помещаются внутрь области дисплея. На клавиатурных
терминалах вы можете также поместить объекты на функциональные клавиши. Экраны
перемещаются и масштабируются подобно любым другим окнам. Одновременно могут
быть открыты несколько экранов.

Заголовок

Окно приложения
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Обращение к объектам

Обращение к объектам осуществляется с помощью меню Objects или окна
инструментов.

Изобразительный указатель

Окно инструментов включается и выключается в меню View

После выделения объекта и перемещения указателя мыши в область дисплея форма
указателя изменяется на перекрестие (+). Перекрестие указывает, где объект
появится, когда вы поместите его.

При перемещении в недопустимую область экрана перекрестие будет выглядеть так:
 .
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Помещение объектов

На терминалах с сенсорным экраном объекты помещаются в область дисплея. На
клавиатурных терминалах объекты помещаются в область дисплея и назначаются
функциональным клавишам. На терминалах, которые поддерживают как
клавиатурный, так и сенсорный ввод, вы помещаете объекты в область дисплея или на
функциональные клавиши.

Для создания объекта в области дисплея:

1. Выберите объект в меню Objects.

Или щелкните соответствующий инструмент в окне инструментов.

2. Разместите указатель (+) там, где вы хотите поместить объект.

3. Щелкните левой кнопкой мыши для помещения объекта с размерами по
умолчанию.

Или нажмите левую кнопку мыши и перетащите указатель для масштабирования
объекта. Отпустите кнопку мыши, когда объект примет нужные размеры. Объект
остается выделенным.

Объект

Перетащите указатель
для масштабирования объекта

4. Для помещения другого объекта такого же типа переместите указатель в новое
местоположение и повторите этап 3.

5. Щелкните правой кнопкой мыши для выхода из режима объекта.

Или щелкните инструмент выделения в окне инструментов.

Или нажмите клавишу Esc.

Для каждого объекта, помещенного на экран, строка статуса показывает:

• Идентификационный номер объекта (назначенный PanelBuilder)

• Координаты X и Y верхнего левого угла объекта (в пикселах). Координаты
отсчитываются от верхнего левого угла дисплея (x=0, y=0).

• Ширину и высоту объекта (в пикселах)

• Тип объекта (правый элемент строки статуса)
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Для создания объекта на функциональной клавише:

1. Выберите объект в меню Objects.

Или щелкните соответствующий инструмент в окне инструментов.

2. Разместите указатель (+) над функциональной клавишей и щелкните левой
кнопкой мыши.

Если функциональная клавиша уже назначена объекту, указатель изменяется на
 . Разместите указатель над другой клавишей.

Указатель над функциональной клавишей

На функциональной клавише появляется графика, показывающая тип объекта.
Рядом с номером клавиши также появляется звездочка.

Графика

Звездочка

F1*

3. Щелкните правую кнопку мыши для выхода из режима объекта.

Или щелкните инструмент выделения в окне инструментов.
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Выделение объектов

Перед тем как вы сможете переместить, промасштабировать или отформатировать
объект, вы должны сначала выделить объект. Выделенный объект имеет
манипуляторы.

Для выделения объекта:

Разместите указатель мыши в любом месте объекта и нажмите левую кнопку мыши. На
объекте появятся манипуляторы.

Прямая имеет по одному манипулятору на каждом конце. Прямоугольники и квадраты
имеют манипуляторы по их краям. Другие объекты (эллипсы и окружности) имеют
манипуляторы по невидимому ограничивающему прямоугольнику.

Для отмены выделения объекта:

• Разместите указатель вне объекта и нажмите левую кнопку мыши.

• Или выделите другой объект.

Для выделения нескольких объектов:

1. Разместите указатель выше и левее объектов, которые вы хотите сгруппировать.

2. Нажмите левую кнопку мыши и очертите прямоугольник выделения вокруг этих
объектов.

Прямоугольник указания

3. Отпустите кнопку мыши.

Другой способ для выделения нескольких объектов состоит в нажатии клавиши Shift и
щелчке каждого объекта. Для добавления или удаления объекта из выделения
нажмите клавишу Shift и щелкните объект.

Для выделения всех объектов:

Выберите Select All в меню Edit.

Манипуляторы появляются на всех объектах, чтобы показать, что все они выделены.
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Масштабирование объектов

Для масштабирования объекта:

1. Выделите объект, щелкнув в любом месте объекта. На объекте появятся
манипуляторы.

Манипулятор

2. Разместите указатель над одним из манипуляторов.

Указатель изменяется, чтобы показать направление, в котором вы можете
масштабировать объект.

Вертикальное
масштабирование

Горизонтальное
масштабирование

Диагональное
масштабирование

3. Нажмите левую кнопку мыши и перетащите манипулятор.

Объект вытягивается от точки закрепления к позиции указателя, расширяясь и
сжимаясь в процессе перемещения вами мыши.

Точка закрепления – это манипулятор, противоположный выбранному вами
манипулятору. Она не перемещается когда объекты масштабируются.

4. Отпустите кнопку мыши, когда объект примет нужный размер.

Объекты с внутренней графикой не могут быть меньше, чем эта графика. Вы можете
переместить или удалить внутреннюю графику для масштабирования объекта
должным образом.

Перемещение объектов

Для перемещения объекта:

1. Переместите указатель в любом месте внутри объекта.

2. Нажмите левую кнопку мыши и перетащите объект в его новое местоположение.
Указатель изменяется, чтобы показать, что вы перемещаете объект. В процессе
перетаскивания вами объекта появляется контур.

Старое местоположение Новое местоположение Новое местоположение

3. Отпустите кнопку мыши.
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Получение справки

Справка по PanelBuilder доступна при выборе команды в меню Help или при нажатии
клавиши F1. Следующее справочное окно открывается, когда вы выбираете Index в
меню Help.
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2 Начальная настройка системы

Задачи главы

Эта глава содержит следующие разделы:

ëåäçàÐ .ðòÑ

âîòíåíîïìîêõûíìåòñèñàêéîðòñàÍ 1-2

CLSèêèãîëéîíòêàòíîê-îíéåëåðûììàðãîðïàêçóðãàÇ 5-2

CLPèêèãîëéîíòêàòíîê-îíéåëåðûììàðãîðïàêçóðãàÇ 5-2

Настройка системных компонентов

Этот раздел описывает, как настроить системные компоненты, которые требуются для
инсталляции, загрузки и запуска примера приложения.

Системные компоненты для PanelView с портами DH-485

• Терминал PanelView DH-485

• Персональный компьютер с инсталлированными:

– PanelBuilder Software

– Advanced Programming Software (APS)

• Контроллер SLC 500

• 2 кабеля связи (номер по каталогу 1747-C10, -C11 или -C20)

• Интерфейсный преобразователь персонального компьютера (номер по каталогу
1747-PIC)

Осуществите подсоединения, показанные ниже. Другие подсоединения не требуются.

Узел 2
Показан терминал PanelView 900 DH-485

Узел 0
Персональный компьютер

Разъем DH-485 Разъем DH-485
Узел 1

Контроллер SLC

Последовательный порт

COM1 или COM2

Интерфейсный преобразователь
персонального компьютера

Номер по каталогу 1747-PIC Кабель
Номер по каталогу 1747-C10, -C11, -C20

PanelBuilder
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Системные компоненты для PanelView с портом RS-232 (DH-485)

• Терминал PanelView RS-232

• Персональный компьютер с инсталлированными:

– PanelBuilder Software

– Advanced Programming Software (APS)

• Контроллер SLC 5/03 или 5/04

• Один кабель связи (номер по каталогу 2711-NC13, -NC14 или 2706-NC13)

Узел 0
Персональный компьютер

PanelBuilder

Последовательный порт
COM1 или COM2

Узел 2
Показан терминал PanelView 900 RS-232

Кабель
Номер по каталогу 2711-NC13,

2711-NC14, 2706-NC13

Узел 1
Контроллер SLC 5/03 или 5/04

К каналу 0

Примечание: Один и тот же кабель используется для передачи приложений на терминал 
и для подсоединения терминала к контроллеру SLC 5/03 или 5/04. После загрузки 
приложения отсоедините кабель от компьютера и подсоедините его к каналу 0 порта 
контроллера SLC 5/03 или 5/04.
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Системные компоненты для PanelView с портом Remote I/O

• Терминал PanelView Remote I/O

• Персональный компьютер с инсталлированными:

– PanelBuilder Software

– 6200 Series Programming Software

• Контроллер PLC

• Один кабель связи RIO (номер по каталогу 1770-CD), соответствует кабелю Belden
9463. Для организации связи по RIO необходимо два разъема, при этом один разъем
для RIO поставляется с терминалом.

• Один кабель связи RS-232 (номер по каталогу 2711-NC13, -NC14 или 2706-NC13)

Узел 0
Персональный компьютер

PanelBuilder

Последовательный порт
COM1 или COM2

Узел 2
Показан терминал PanelView 900 Remote I/O

Порт RS-232
Порт Remote I/O

3-контактный блочный разъем

Кабель
Номер по каталогу 1770-CD

(Belden 9463)

Узел 1
Контроллер PLC-5

Порт PLC RIO

Кабель
Номер по каталогу 2711-NC13,

2711-NC14, 2706-NC13
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Системные компоненты для PanelView с портом DH+

• Терминал PanelView DH+

• Персональный компьютер с инсталлированными:

– PanelBuilder Software

– 6200 Series Programming Software

• Контроллер PLC-5

• Один кабель связи (номер по каталогу 1770-CD), соответствует кабелю Belden 9463.

• Один кабель связи RS-232 (номер по каталогу 2711-NC13, -NC14 или 2706-NC13)

Узел 2
Показан терминал PanelView 900 DH+

Порт RS-232 Порт DH+
3-контактный блочный разъем

Резистор
82 Ом или 150 Ом

2
SH
1

Синий
Экран
Без изоляции

Без изоляции
Экран
Синий

1
SH
2

Порт PLC DH+

Узел 1
Контроллер PLC-5

Узел 0
Персональный компьютер

PanelBuilder

Последовательный порт
COM1 или COM2

Кабель
Номер по каталогу 2711-NC13,

2711-NC14, 2706-NC13

2 1
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Загрузка программы релейно-контактной логики SLC

Для приложений DH-485 или DH+, которые взаимодействуют с контроллером SLC,
требуемая программа релейно-контактной логики и файлы данных поставляются на
инсталляционных дисках PanelBuilder.

Следующие файлы инсталлируются в директорию C:\AB\SLC500\GS в процессе
инсталляции PanelBuilder.

èêèãîëéîííåâçîãîíìûëéàÔ
CLS

$CA.DTRTSTEG $XL.DTRTSTEG

HCA.DTRTSTEG MAN.DTRTSTEG

$0B.DTRTSTEG $PO.DTRTSTEG

$1B.DTRTSTEG $CP.DTRTSTEG

$2B.DTRTSTEG $DX.DTRTSTEG

$XI.DTRTSTEG $OX.DTRTSTEG

Запустите программное обеспечение APS, инсталлированное на вашем компьютере, и
загрузите программу релейно-контактной логики в контроллер SLC. Приложение A
содержит задокументированную программу релейно-контактной логики.

Для получения более подробной информации о том, как использовать Advanced
Programming Software, обратитесь к соответствующим руководствам.

Загрузка программы релейно-контактной логики PLC

Для приложений Remote I/O и DH+, которые взаимодействуют с контроллером PLC 5,
требуемая программа релейно-контактной логики и файлы данных поставляются на
инсталляционных дисках PanelBuilder.

Следующие файлы инсталлируются в директорию C:\AB\PLC5\GS в процессе
инсталляции PanelBuilder.

èêèãîëéîííåâçîãîíìûëéàÔ
)OIR(CLP

èêèãîëéîííåâçîãîíìûëéàÔ
)+HD(CLP

$CA.OIRSG $XL.OIRSG 5FA.PHDSG $XL.PHDSG

5FA.OIRSG $PO.OIRSG $CA.PHDSG $PO.PHDSG

$0B.OIRSG $1P.OIRSG $0B.PHDSG $1P.PHDSG

$1B.OIRSG $CP.OIRSG $1B.PHDSG $CP.PHDSG

$1D.OIRSG LTT.OIRSG $1D.PHDSG

$XI.OIRSG $XI.PHDSG

Загрузите программу релейно-контактной логики в контроллер PLC. Приложение B
содержит релейно-контактную логику для приложения Remote I/O. Приложение C
содержит релейно-контактную логику для приложения DH+.

Для получения более подробной информации о том, как загрузить программу
релейно-контактной логики в контроллер PLC, обратитесь к соответствующим
руководствам пользователя.
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3 Обзор примера приложения

Задачи главы

Эта глава содержит следующие разделы:

ëåäçàÐ .ðòÑ

ÿèíåæîëèðïåèíå÷àíçàÍ 1-3

ÿèíåæîëèðïûíàðêÝ 2-3

sutatSrotoMíàðêÝ 3-3

deepSrotoMíàðêÝ 4-3

rennaBmralA 5-3

ÿèíåæîëèðïèãåÒ 6-3

+HDèëè584-HDÿèíåæîëèðïèãåÒ 7-3

O/IetomeRÿèíåæîëèðïèãåÒ 8-3

Назначение приложения

Приложение Getting Started содержит объекты для управления и контроля статуса
двигателя. Терминал PanelView читает / записывает данные:

• либо в контроллер SLC 500 по сети DH-485

• либо в контроллер SLC 500 или контроллер PLC 5 по сети DH+

• либо в контроллер PLC 5 по сети Remote I/O

Глава 4 предоставляет алгоритмы создания приложения на монохромном терминале
PanelView 900 с функциональными клавишами.

• При создании приложения для любого терминала PanelView с сенсорным экраном
сенсорная ячейка ввода автоматически разрешена.

• При создании приложения для цветного терминала PanelView в алгоритмах
используются цвета.

Для полутоновых терминалов PanelView палитра цветов показывает 4 градации
серого. Выделите соответствующие градации.

• При создании приложения для других терминалов PanelView используйте
соответствующие текстовые размеры.

Вы можете открыть любой из файлов .PBA, сохраненных в AB\PBWIN\GS, для
просмотра приложения начала работы на вашем компьютере.
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Экраны приложения

Приложение содержит 3 экрана:

• Motor Status

• Motor Speed

• Alarm Banner (только V2.0 или более позднее программное обеспечение)

Каждый из экранов Motor Status и Motor Speed содержит экранную кнопку,
позволяющую вам перемещаться между двумя экранами.

Alarm Banner – это глобальный дисплей, который появляется поверх экрана Motor
Status или Motor Speed при инициализации сигнала тревоги. Сигналы тревоги
поддерживаются в PanelBuilder V2.0 (или в более позднем).

Для терминалов с сенсорным экраном приложение содержит кнопку Config Screen,
позволяющую оператору отображать меню Configuration Mode терминала при
выполнении приложения.



Обзор примера приложения

3-3

Экран Motor Status

Экран Motor Status – это первый экран, который появляется, когда вы включаете
терминал PanelView. Он позволяет вам:

• запускать и останавливать двигатель

• настраивать управление двигателем в автоматический или ручной режим

• контролировать статус (запуска / останова) и режим (автоматический / ручной)
двигателя

• переходить к экрану Motor Speed

Клавиатурный терминал Терминал с сенсорным экраном

В следующей таблице перечислены объекты на экране Motor Status и функции
каждого объекта. Заголовки объектов созданы как текст заднего плана.

òêåúáÎ àòêåúáîïèÒ ÿèöêíóÔ

ÿèíåëâàðïóêîñèïñéûíòðàäíàòÑ
àíàëïîãåíäàçìîòñêåòñ

èëèéèêñå÷èòàìîòâàâüëåòàãèâäòåàâèàðòñàÍ
èëèõðåââàðîñðóêìåèíåùåìåðåïìèæåðéîí÷óð

.retnEèøèâàëêìåèòàæàíèçèíâ

èøèâàëêòåóáåðòìîíàðêýìûíðîñíåññëàíèìðåÒ
óêñèïñîïàðîñðóêÿèíåùåìåðåïÿëäàêñèïñ

.èèöïîÿèíåëåäûâèÿèíåëâàðïó

.àêïîíêÿàííåìåðâîêòàðK
åíèèíÿîòñîñìîíüëàìðîíÂ(

)àòàæàí

óøèâàëêåòåàìèæàíûâàäãîê,üëåòàãèâäòåàêñóïàÇ
.àòêåúáîîãîííàðêýîãîòýüñåòåàñàêèëè1F

.àêïîíêÿàííåìåðâîêòàðK
åíèèíÿîòñîñìîíüëàìðîíÂ(

)àòàæàí

åòåàìèæàíûâàäãîê,üëåòàãèâäòåàâèëâàíàòñÎ
îãîííàðêýîãîòýüñåòåàñàêèëè2Fóøèâàëê

.àòêåúáî

óíàðêýêàäîõåðåïàêïîíK
ûâàäãîê,deepSrotoMíàðêýòåàæàðáîòÎ

)055VPõàëàíèìðåòàí5F(8Fóøèâàëêåòåàìèæàí
.àòêåúáîîãîííàðêýîãîòýüñåòåàñàêèëè

ñûðîòàêèäíèåûííîèöèçîï-2
àíàëïîãåíäàçìîòñêåò

èëÿñòèäîõàíòåàâûçàêîïEDOMðîòàêèäíÈ
.LAUNAMèëèOTUAåìèæåðâüëåòàãèâä

èëíå÷þëêâòåàâûçàêîïSUTATSðîòàêèäíÈ
.)POTS(íå÷þëêûâèëè)TRATS(üëåòàãèâä

AUTO
MANUAL

SELECT MODE

START
MOTOR

F1

STOP
MOTOR

F2

Motor
Status

F8

MOTOR  STATUS

STATUS
START

MODE
MANUAL
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Экран Motor Speed

Экран Motor Speed позволяет вам:

• контролировать скорость двигателя

• увеличивать или уменьшать скорость двигателя

• задавать новую скорость двигателя

• переходить к экрану Motor Status

Клавиатурный терминал Терминал с сенсорным экраном

В следующей таблице перечислены объекты на экране Motor Speed и функции каждого
объекта. Заголовки объектов созданы как текст заднего плана.

òêåúáÎ àòêåúáîïèÒ ÿèöêíóÔ

ìîòñêåòñàäîââîãîâîëñè÷åëîÏ
àíàëïîãåíäàç

èòñîðîêñéîâîíàäîââÿëäòîíêîëáòåàâûðêòÎ
.)íèì/.áî0001îä0òî(ÿëåòàãèâä

õûííàäõûâîëñè÷éåëïñèÄ
0001îä0òî(üòñîðîêñþóùóêåòòåàæàðáîòÎ

.ÿëåòàãèâä)íèì/.áî

àëàêøèàììàðãàèäÿàâîêèáëîòÑ
àíàëïîãåíäàçìîòñêåòñ

îä0òî(ÿëåòàãèâäüòñîðîêñþóùóêåòòåàæàðáîòÎ
.åìðîôéîêñå÷èôàðãâ)íèì/.áî0001

èõèðòøååèûììàðãàèäéîâîêèáëîòñàëàêØ
.ûòêåúáîåûíüëåäòîêàêÿñòþàäçîñ

ÿàíìèæàíÿàííåìåðâîêòàðK
ìîíüëàìðîíÂ(.àêïîíê

)àòàæàíåíèèíÿîòñîñ

ûâàäãîê,ÿëåòàãèâäüòñîðîêñòåàâè÷èëåâÓ
îãîòýüñåòåàñàêèëè1Fóøèâàëêåòåàìèæàí

.àòêåúáîîãîííàðêý

ÿàíìèæàíÿàííåìåðâîêòàðK
ìîíüëàìðîíÂ(.àêïîíê

)àòàæàíåíèèíÿîòñîñ

åòåàìèæàíûâàäãîê,ÿëåòàãèâäüòñîðîêñòåàøüíåìÓ
îãîííàðêýîãîòýüñåòåàñàêèëè2Fóøèâàëê

.àòêåúáî

óíàðêýêàäîõåðåïàêïîíK
ûâàäãîê,sutatSrotoMíàðêýòåàæàðáîòÎ

)055VPõàëàíèìðåòàí5F(8Fóøèâàëêåòåàìèæàí
.àòêåúáîîãîííàðêýîãîòýüñåòåàñàêèëè

#### RPM

ENTER SPEED

#### RPM

1000

0

Motor Speed

INC  SPD
F1

DEC  SPD
F2

Motor
Status

F8
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Alarm Banner

Alarm Banner – это глобальный дисплей, который появляется поверх экрана Motor
Status или Motor Speed при инициализации сигнала тревоги. Он позволяет вам:

• читать сообщение, связанное с инициализированным сигналом тревоги

• удалять Alarm Banner с экрана

• подтверждать сигнал тревоги и удалять это сообщение с экрана

Клавиатурный терминал

В следующей таблице перечислены объекты на экране Motor Speed и функции каждого
объекта. Message Display – стационарный объект, который не может быть удален.

òêåúáÎ àòêåúáîïèÒ ÿèöêíóÔ

éèíåùáîîñéåëïñèÄ
àäãîê,ÿèíåùáîîñåèíåæàðáîòîòåóðèçèëàèöèíÈ

ìîêøèëñèëèÿàêîñûâìîêøèëñÿëåòàãèâäüòñîðîêñ
.ÿàêçèí

âîëàíãèñÿèíåëàäóàêïîíK
èãîâåðò

ûâàäãîê,àíàðêýñrennaBmralAòåÿëàäÓ
îãîòýüñåòåàñàêèëè4Fóøèâàëêåòåàìèæàí

.àòêåúáîîãîííàðêý

âîëàíãèñÿèíåäæðåâòäîïàêïîíK
èãîâåðò

àíéûííåæàðáîòî,èãîâåðòëàíãèñòåàäæðåâòäîÏ
,àíàðêýñåèíåùáîîñîòýòåÿëàäóè,rennaBmralA

üñåòåàñàêèëè7Fóøèâàëêåòåàìèæàíûâàäãîê
.àòêåúáîîãîííàðêýîãîòý

MOTOR SPEED TOO LOW

MOTOR SPEED TOO HIGH

Clear
F4

Ack
F7
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Теги приложения

Пример приложения имеет набор тегов чтения / записи, которые определяют, как
объекты взаимодействуют с адресами контроллера SLC 500 или PLC. Следующая
таблица определяет атрибуты каждого тега.

âîãåòûòóáèðòÀ åèíàñèïÎ

emaNgaT àãåòñåðäàååùþÿëåäåðïî,ÿìèåîíüëàêèíÓ

epyTataD
,âèññàìéûâîòèá,åîëåöåîâîêàíç/åîâîêàíççåá,DCB4,òèÁ

îëñè÷åîííåâòñåùåâ,âèññàìéûíüëîâìèñ

eziSyarrA àâèññàìîãîâîòèá)àíèëä(ðåìçàÐ

noitpircseD àãåòåèíàñèïîåîíâîíñÎ

emaNedoN ìîãåòñîãîííàçÿâñ,àðåëëîðòíîêÿìÈ

sserddAgaT õûííàäûöèëáàòòèáèëèîâîëñòåàäàÇ

eulaVlaitinI èèíå÷þëêâèðïàãåòóñåðäàîïåîìåÿíàðõîñ,åèíå÷àíÇ

ycneuqerFetadpU àãåòóñåðäàîïåèíå÷àíçÿñòåÿëâîíáîéîðîòîêñ,àòîòñà×

gnillacS 1 ÿèíåùåìñèÿëåòèæîíìÿèíå÷àíÇ

stimiLyrtnEataD 1 àãåòóñåðäàîïõûìåÿíàðõîñ,õûííàäûëåäåðïéèíæèíèéèíõðåÂ

1 êàíççåá/åîâîêàíç,DCB4�õûííàäïèòèëñåîêüëîò,ÿñòþàæàðáîòîÿëîïèòÝ âîëñè÷èëèåîëåöåîâî
.ëåñè÷õûííåâòñåùåâEEEIåòàìðîô

Теги, используемые приложением DH-485 или DH+, сохраняются в базе тегов, к
которой происходит обращение через проект с именем GS. Проект GS имеет 9 тегов.

Теги, используемые приложением Remote I/O, сохраняются в базе данных, к которой
происходит обращение через проект GSRIO. Проект GSRIO имеет 12 тегов. Теги
создаются с помощью Tag Editor.

Объекты, которые не осуществляют чтение или запись по адресу контроллера, такие
как кнопки смены экранов и текст заднего плана, не требуют тега.
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Теги приложения DH-485 или DH+

Этот раздел определяет теги проекта GS, которые используются приложением DH-485
или DH+.

• Для приложения DH-485 эти теги осуществляют чтение или запись данных в
битовых или целочисленных файлах, связанных с контроллером SLC 500.

• Для приложения DH+ эти теги осуществляют чтение или запись данных в битовых
или целочисленных файлах, связанных с контроллером SLC 500 или PLC 5/25.

+HDèëè584-HDÿèíåæîëèðïÿëäSGàòêåîðïèãåÒ

òêåúáîòîòÝ ãåòòîòýòåóçüëîïñÈ ÿëÄ

tratS_rotoM
dnI_tratS_rotoM

â0/0:3BàòèáéîêâîíàòñóÿëåòàãèâäàêñóïàÇ
ÿèíåëâàðïóåèíÿîòñîÑ.)1(NOåèíÿîòñîñ

òèáàíàðåëëîðòíîêìåèâòñéåäçîâÿñòåàæàðáîòî
.4/0:3B

potS_rotoM
dnI_potS_rotoM

â1/0:3BàòèáéîêâîíàòñóÿëåòàãèâäàâîíàòñÎ
ÿèíåëâàðïóåèíÿîòñîÑ.)0(FFOåèíÿîòñîñ

òèáàíàðåëëîðòíîêìåèâòñéåäçîâÿñòåàæàðáîòî
.5/0:3B

dnI_potS_rotoM
)POTSèëèTRATS(àñóòàòñîãåùóêåòÿèíåæàðáîòÎ

.5/0:3Bàòèáìåèíåò÷ÿëåòàãèâä

launaMotuA_rotoM
LAUNAMèëèOTUAìèæåðâÿëåòàãèâäàäîâåðåÏ
.0:7Nâÿèíå÷àíçîãîëåöîãîâîêàíççåáþüñèïàç

launaMotuA_rotoM
)LAUNAMèëèOTUA(àìèæåðîãåùóêåòÿèíåæàðáîòÎ

.0:7Nâõûííàäìåèíåò÷ÿëåòàãèâä

deepS_rotoM
0001îä0òî(ÿëåòàãèâäèòñîðîêñéîâîíÿèíàäàÇ

âÿèíå÷àíçîãîëåöîãîâîêàíççåáþüñèïàç)íèì/.áî
.1:7N

dnI_deepS_rotoM

âÿëåòàãèâäèòñîðîêñéåùóêåòÿèíåæàðáîòÎ
.2:7Nâõûííàäìåèíåò÷åìðîôéîêñå÷èôàðã

ceD_deepS_rotoM
àòèáéîêâîíàòñóÿëåòàãèâäèòñîðîêñÿèíåøüíåìÓ

.)0(FFOè)1(NOåèíÿîòñîñâ3/0:3B

cnI_deepS_rotoM
àòèáéîêâîíàòñóÿëåòàãèâäèòñîðîêñÿèíå÷èëåâÓ

.)0(FFOè)1(NOåèíÿîòñîñâ2/0:3B

segasseM
àíÿèíåùáîîñÿèíåëâÿîïÿèíàâîðèçèëàèöèíÈ
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Теги приложения Remote I/O

Этот раздел определяет теги проекта GSRIO, которые используются приложением
Remote I/O. Эти теги осуществляют чтение и запись данных в битовых, целочисленных
файлах и файлах ввода / вывода, связанных с контроллером PLC 5/25 со связью
Remote I/O.
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4 Создание примера приложения

Задачи главы

Эта глава показывает как создать пример приложения и содержит приведенные ниже
разделы.

Вы можете создать приложение целиком или его часть. Завершенные приложения DH-
485 (или DH+) и Remote I/O поставляются на инсталляционных дисках и сохраняются
в C:\AB\PBWIN\GS\

ëåäçàÐ .ðòÑ

redliuBlenaPêñóïàÇ 2-4

ÿèíåæîëèðïàëéàôîãîâîíåèòûðêòÎ 3-4

sutatSrotoMàíàðêýåèíàäçîÑ 4-4

àíàðêýîãîâîíåèòûðêòÎ 4-4

èêòåñâîòóáèðòààêéîðòñàÍ 5-4

rotoMtratSèêïîíêåèíàäçîÑ 6-4

rotoMpotSèêïîíêåèíàäçîÑ 8-4

deepSrotoMèêïîíêéîííàðêýåèíàäçîÑ 11-4

neercSgifnoCotoGèêïîíêåèíàäçîÑ 21-4

edoMtceleSÿèíåëâàðïóàêñèïñåèíàäçîÑ 31-4

ÿèíåëâàðïóàêñèïñøèâàëêåèíàäçîÑ 61-4

edoMàðîòàêèäíèåèíàäçîÑ 71-4

sutatSàðîòàêèäíèåèíàäçîÑ 12-4

sutatSrotoMàíàðêýåèòûðêàÇ 42-4

deepSrotoMàíàðêýåèíàäçîÑ 52-4

âîòåâöûðòèëàïèâîòíåìóðòñíèàíêîåèòûðêòÎ 52-4

àíàðêýîãîâîíåèòûðêòÎ 62-4

deepSesaercnIèêïîíêåèíàäçîÑ 62-4

deepSesaerceDèêïîíêåèíàäçîÑ 82-4

sutatSrotoMèêïîíêéîííàðêýåèíàäçîÑ 92-4

deepSûëàêøèûììàðãàèäéîâîêèáëîòñåèíàäçîÑ 13-4

deepSàäîââîãîâîëñè÷àòêåúáîåèíàäçîÑ 43-4

MPRõûííàäÿåëïñèäåèíàäçîÑ 73-4

âîòåâöûðòèëàïèâîòíåìóðòñíèàíêîåèòûðêàÇ 93-4

deepSrotoMàíàðêýåèòûðêàÇ 93-4

deepSrotoMèsutatSrotoMâîíàðêýåèíàâûçÿâÑ 93-4

èãîâåðòâîëàíãèñåèíàäçîÑ 04-4

ÿèíåæîëèðïåèíåíàðõîÑ 34-4
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Запуск PanelBuilder

Для запуска PanelBuilder 900:

• Для компьютеров с Windows 3.x:

– После приглашения DOS введите win и нажмите Enter.

– Дважды щелкните пиктограмму группы PanelBuilder в Program Manager.

– Дважды щелкните пиктограмму PanelBuilder.

• Для компьютеров с Windows 95:

– Щелкните один раз кнопку Start. Поместите курсор поверх Programs. Вы
увидите подменю Programs.

– Поместите курсор поверх PanelBuilder. Вы увидите подменю PanelBuilder.

– Щелкните пиктограмму PanelBuilder.

Откроется экран запуска, показывающий информацию об авторском праве и
реализации.

xx.xx.xx
xxx xx xxxx

Откроется окно PanelBuilder. Это – ваше рабочее пространство для создания
экранов приложения.

Кнопка
максимального
окна

Щелкните кнопку максимального окна для распахивания окна во весь экран.
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Открытие нового файла приложения

Для открытия нового файла приложения:

1. Выберите New в меню File или щелкните  на панели инструментов.

Откроется диалоговое окно New Application.

2. В окне Application Name введите Getting Started.

3. В окне Project Name введите:

– GSRIO для приложения Remote I/O

– GS для приложения DH-485 или DH+

Проект будет содержать теги и информацию об устройствах.

4. В окне Terminal Name введите PV550, PV600, PV900 или PV1400. Это имя
определяет терминал для проекта.

5. Выберите конкретный терминал PanelView, выделив:

– PV550, PV600, PV900M (монохромный), PV900C (цветной), PV1400 в окне PV
Type

– Keypad или Touch

– Catalog Number и Firmware Version терминала

Область Ports показывает порт(ы) и протокол(ы) связи выделенного терминала.

Введите Getting Started

Введите GSRIO или GS

Введите PV550, PV600, PV900 или PV1400

Выделите PV550, PV600, PV900M, PV900C, PV1400

Выделите номер в каталоге терминала Remote I/O, DH+ или DH-485

Порт и протокол связи указанного терминала

Выделите Keypad или Touch

6. Щелкните кнопку OK.

Откроется окно файла приложения, показывая имя приложения и выделенный тип
терминала. Так как файл не содержит ни одного экрана, окно Screens – пустое.

Имя приложения
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Создание экрана Motor Status

Этот раздел показывает, как создать экран MOTOR STATUS, который является первым
экраном приложения.

Выделите список управления Mode

Алгоритмы этого раздела показывают, как:

• Открыть новый экран

• Настроить атрибуты сетки

• Создать кратковременную кнопку для запуска двигателя

• Создать кратковременную кнопку для останова двигателя

• Создать экранную кнопку для отображения экрана Motor Speed

• Создать список управления для выделения автоматического или ручного режима

• Создать клавиши списка управления для терминалов только с сенсорными
экранами

• Создать индикатор для показа автоматического / ручного режима двигателя

• Создать индикатор для показа статуса запуска / останова двигателя

• Закрыть экран Motor Status

Открытие нового экрана

Для создания экрана MOTOR STATUS:

1. Выберите New в меню File или щелкните  на панели инструментов.

PanelBuilder назначает имя / номер каждому экрану, начиная с 1.

2. Введите Motor Status в окне Name

Введите Motor Status

Задний план появляется только на цветных терминалах

3. Щелкните кнопку OK для открытия экрана 1.
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Откроется чистый экран приложения. Заголовок показывает имя и номер экрана.

Звездочка (*) после имени файла приложения в заголовке означает, что приложение
было модифицировано, но не сохранено.

Имя проекта Имя файла приложения после сохранения

Заголовок

Номер и имя экрана
Щелкните заголовок для перемещения

экрана в рабочем пространстве

Настройка атрибутов сетки

Для более легкого выравнивания и позиционирования экранных объектов мы
рекомендуем вам отрегулировать Grid Spacing.

Для настройки атрибутов сетки:

1. В меню Align выберите Grid Attributes.

Откроется диалоговое окно Grid Spacing.

2. Щелкните в окне X Pixels и замените 13 на 5.

3. Щелкните в окне Y Pixels и замените 25 на 5.

Эти настройки различны для каждого типа терминала PanelView.

4. Щелкните OK.
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Создание кнопки Start Motor

Для создания кнопки 
START
MOTOR

F1
 :

1. В подменю Objects > Push Buttons выберите Momentary.

2. Разместите указатель (+) в нижней левой области экрана, щелкните левой
кнопкой мыши и перетащите указатель диагонально для масштабирования
кнопки.

3. Щелкните правой кнопкой мыши для выхода из режима кнопки.

Для настройки свойств кнопки:

1. Дважды щелкните кнопку для открытия ее диалогового окна.

2. Настройте свойства, как показано ниже.

Щелкните Single Bit

Укажите F1

Введите Motor_Start

Введите Motor_Start_Ind
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Для конфигурирования состояний кнопки Start Motor:

1. Щелкните закладку States диалогового окна Push Buttons.

Откроется таблица. Каждая строка представляет состояние кнопки (строка 0 –
состояние 0, строка 1 – состояние 1).

Состояние 0
Состояние 1

Используйте горизонтальную линейку прокрутки
для отображения полей, которые не видны

2. Отредактируйте поля для состояния 0 (строка 0) следующим образом:

• Дважды щелкните в поле Text и:

– введите START, затем нажмите Enter (/*R*/ указывает на возврат
каретки)

– введите MOTOR, затем нажмите Enter (/*R*/ указывает на возврат
каретки)

– введите F1

• Щелкните в поле Text Size и выделите 16x24 в списке. Не изменяйте
текстовый размер для приложений PV550.

Выделите следующие цвета для состояния 0. Щелкните в каждом поле и выделите:

• Light Green для Object Background

• Black для Object Foreground

• Light Green для Text Background

• Black для Text Foreground

3. Отредактируйте поля для состояния 1 (строка 1) следующим образом:

• Дважды щелкните в поле Text, нажмите Enter (/*R*/), затем введите MOTOR
STARTED

• Выделите Black для Object Background

• Выделите White для Object Foreground

• Выделите Black для Text Background

• Выделите White для Text Foreground

• Щелкните в поле Text Size и выделите 16x24 в списке. Не изменяйте
текстовый размер для приложений PV550.

START
MOTOR

F1

Состояние 0

Для цветных

MOTOR
STARTED

Состояние 1
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Выделите следующие цвета для состояния 1 (строка 1):

• White для Object Background

• White для Object Foreground

• White для Text Background

• Green для Text Foreground

4. Щелкните кнопку OK для выхода из диалогового окна Push Buttons.

Звездочка (*) появляется, если размер текста превышает размер объекта.

5. Промасштабируйте объект, если это необходимо для соответствия с текстом.

Создание кнопки Stop Motor

Кнопка Stop Motor создается с использованием функций Copy и Paste.

Для создания кнопки Stop Motor:

1. Выделите 
START
MOTOR

F1
 (если не выделена).

2. В меню Edit выберите Copy или щелкните  на панели инструментов.

3. В меню Edit выберите Paste или щелкните  на панели инструментов.

Появляется контур скопированной кнопки.

4. Переместите контур вправо и щелкните левой кнопкой мыши для вклеивания
кнопки.

Для цветных
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Для настройки свойств кнопки:

1. Дважды щелкните вклеенную кнопку для открытия ее диалогового окна.

2. Настройте свойства, как показано ниже.

Выделите F2

Введите Motor_Stop

Введите Motor_Stop_Ind
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Для конфигурирования состояний кнопки Stop Motor:

1. Щелкните закладку States диалогового окна Push Buttons.

2. Дважды щелкните в поле Text состояния 0 (строка 0) и замените START/*R*/
MOTOR/*R*/F1 на STOP/*R*/MOTOR/*R*/F2.

Помните, что /*R*/ указывает на возврат каретки.

Выделите следующие цвета для состояния 0 (строка 0):

• Light Red для Object Background

• Black для Object Foreground

• Light Red для Text Background

• White для Text Foreground

3. Дважды щелкните в поле Text состояния 1 (строка 1) и замените /*R*/MOTOR
STARTED на /*R*/MOTOR STOPPED.

Выделите следующие цвета для состояния 1 (строка 1):

• White для Object Background

• White для Object Foreground

• White для Text Background

• Light Red для Text Foreground

4. Щелкните кнопку OK для закрытия диалогового окна Push Buttons.

STOP
MOTOR

F2

Состояние 0

MOTOR
STOPPED

Состояние 1

Для цветных

Для цветных
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Создание экранной кнопки Motor Speed

Для создания экранной кнопки Motor Speed:

1. В подменю Objects > Screen Selectors выберите Goto.

2. Разместите указатель (+) в нижней правой области экрана, нажмите левую кнопку
мыши и перетащите указатель диагонально для масштабирования кнопки.

3. Щелкните правую кнопку мыши для выхода из режима экранной кнопки.

4. Для монохромных приложений выберите Toggle Fore / Background в меню Format

или щелкните  на панели форматирования.

Выделите Light Blue в меню Format > Background Color

Для изменения внутреннего текста экранной кнопки:

1. В меню Format выберите Inner Text или щелкните инструмент Inner Text  на

панели инструментов.

Не беспокойтесь по поводу этого номера.
Он не имеет значения

2. Замените GoTo на MOTOR SPEED F8

Клавиша Enter нажималась дважды

3. В меню Format > Text Size выберите 16x24.

Или щелкните  на панели форматирования и выберите 16x24 в меню. Не

изменяйте текстовый размер для приложений PV550.

Выделите Light Blue в меню Format > Background Color

4. Щелкните  для выхода из режима внутреннего текста.

Для цветных

Для цветных
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Создание кнопки Goto Config Screen

Пропустите этот раздел, если у вас клавиатурный терминал PanelView 900 или 1400.

Терминалы PanelView 900 / 1400 Touch Screen требуют кнопку Goto Config Screen на
экране. Эта кнопка разрешает оператору отображать Configuration Mode Menu
терминала при выполнении приложения.

Кнопка CONFIG SCREEN

Для создания кнопки CONFIG SCREEN:

1. В подменю Objects > Screen Selectors выберите Goto Config Screen.

2. Разместите указатель (+) слева от кнопки Motor Speed, нажмите левую кнопку
мыши и перетащите указатель диагонально для масштабирования кнопки.

3. Щелкните правой кнопкой мыши для выхода из режима экранной кнопки.

4. В меню Format выберите Toggle Fore / Background или щелкните  на панели

форматирования.

Выделите Red в меню Format > Background Color.

5. В меню Format выберите Inner Text или щелкните 

6. Замените Goto Config Screen на CONFIG SCREEN.

Символы /*R*/ вставляются, когда вы нажимаете Enter.

Не беспокойтесь, если этот номер другой

Клавиша Enter нажималась дважды

7. В меню Format > Text Size выберите 16x24.

Или щелкните  на панели форматирования и выберите 16x24 в меню. Не

изменяйте текстовый размер для приложений PV550.

Выделите Red в меню Format > Background Color.

8. Щелкните  для выхода из режима внутреннего текста.

Для цветных

Для цветных
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Создание списка управления Select Mode

Для создания списка управления Select Mode:

Выделите список управления Select Mode

1. В меню Objects > Control List Selectors выберите Standard.

2. Разместите указатель (+), нажмите левую кнопку мыши и перетащите указатель
для масштабирования объекта.

3. Щелкните правой кнопкой мыши для выхода из режима смены списка управления.

• Выделите Blue в меню Format > Foreground Color.

• Выделите Light Cyan в меню Format > Background Color.

Для настройки свойств списка управления Select Mode:

1. Дважды щелкните объект списка управления для открытия его диалогового окна.

2. Настройте свойства, как показано ниже.

Щелкните опцию Wrap Around

Введите Motor_Automanual

Для цветных



Создание примера приложения

4-14

Для редактирования состояний списка управления Select Mode:

1. Щелкните закладку States диалогового окна Control List Selector.

Удалите состояния (строки) 2 – 15

2. Удалите состояния 2 – 15. Эти состояния не используются.

• щелкните на строке с номером 2.

• нажмите левую кнопку мыши и перетаскивайте мышь до тех пор, пока строки
со 2 по 15 не будут выделены.

• щелкните правой кнопкой мыши и выберите Delete State в контекстном меню.

3. Отредактируйте поля для состояния 0 (строка 0) следующим образом:

• В поле Text замените ST 0 на AUTO.

• В поле Text Size выделите 16x24 в окне списка. Не изменяйте текстовый
размер для приложений PV550.

Выделите Blue в поле Text Foreground.

4. В поле Text состояния 1 (строка 1) замените ST 1 на MANUAL.

Выделите Blue в поле Text Foreground.

5. Щелкните OK для закрытия диалогового окна.

Объект должен выглядеть так:

Звездочка (*) появляется, если размер текста превышает размер объекта.

6. Промасштабируйте объект, если это необходимо для соответствия с текстом.

Для цветных

Для цветных
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Для создания заголовка SELECT MODE для списка управления:

В подменю Objects > Graphics выберите Text.

1. Разместите указатель (+) над списком, нажмите левую кнопку мыши и перетащите
указатель для масштабирования текстового блока.

2. В окне Text введите SELECT MODE.

Не беспокойтесь, если этот номер другой

3. Щелкните  на панели форматирования и выберите 16x24. Не изменяйте

текстовый размер для приложений PV550.

Звездочка (*) появляется, если размер текста превышает размер объекта.

• Выделите Light Cyan в меню Format > Foreground Color.

• Выделите Black в меню Format > Background Color.

4. Щелкните правой кнопкой мыши для выхода из режима текстового объекта.

5. Щелкните  для выхода из режима внутреннего текста.

6. Промасштабируйте текстовый блок, если это необходимо для соответствия с
текстом.

Для цветных
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Создание клавиш списка управления

Пропустите этот раздел, если у вас клавиатурный терминал PanelView.

Терминалы PanelView 900 Touch Screen требуют, чтобы вы поместили клавиши списка
Move Up, Move Down и Enter на экран. Эти клавиши разрешают оператору перемещать
курсор в списке управления и выделять опцию.

Клавиша Move Up

Клавиша Move Down

Клавиша Enter

Для создания клавиши списка Move Up:

1. В подменю Objects > List выберите Move Up.

2. Разместите указатель в верхнем правом углу списка управления Select Mode и
щелкните левой кнопкой мыши. Промасштабируйте и переместите клавишу, если
это необходимо.

• Выделите Blue в меню Format > Foreground Color.

• Выделите Light Cyan в меню Format > Background Color.

• Щелкните инструмент Inner Graphic на панели инструментов  , выделите

Light Cyan для Format > Background Color и Blue для Object > Foreground Color,

затем щелкните  снова.

Для создания клавиши списка Move Down:

1. В подменю Objects > List Keys выберите Move Down.

2. Разместите указатель под клавишей Move Up и щелкните левую кнопку мыши.
Промасштабируйте и переместите клавишу, если это необходимо.

Примените те же цвета, что и для клавиши Move Up.

Для создания клавиши списка Enter:

1. В подменю Objects > List Keys выберите Enter.

2. Разместите указатель под клавишей Move Down и щелкните левую кнопку мыши.
Промасштабируйте и переместите клавишу, если это необходимо.

Примените те же цвета, что и для клавиши Move Up

Для цветных

Для цветных

Для цветных PV900
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Создание индикатора Mode

Выделите список управления Mode Многопозиционные индикаторы

Рамка

Окно Motor Status содержит два индикатора:

• Индикатор MODE (отображает режим Auto / Manual двигателя)

• Индикатор STATUS (отображает статус Start / Stop двигателя)

Для создания рамки вокруг индикаторов:

1. В подменю Objects > Graphics выберите Rectangle.

2. Разместите указатель (+) там, где вы хотите начать вычерчивание верхнего левого
угла формы.

3. Нажмите левую кнопку мыши и перетащите указатель для масштабирования
формы. Отпустите кнопку мыши, когда форма примет нужный размер.

4. Щелкните правой кнопкой мыши для выхода из режима прямоугольника.

Вы будете создавать статусные индикаторы
внутри этого прямоугольника

Выделите Yellow в подменю Format > Background Color.Для цветных
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Для создания индикатора MODE:

Индикатор Mode

1. В подменю Objects > Indicators выберите Multistate.

2. Разместите указатель (+) в нижней левой области окна, нажмите левую кнопку
мыши и перетащите указатель для масштабирования индикатора.

3. Щелкните правую кнопку мыши для выхода из режима многопозиционного
индикатора.

4. Выберите None в подменю Format > Line Type.

Или щелкните  на панели форматирования и выберите None.

Для настройки свойств индикатора MODE:

1. Дважды щелкните объект индикатора для открытия его диалогового окна.

2. Настройте свойства, как показано ниже.

Щелкните Value

Введите Motor_AutoMan_Ind (для Remote I/O)
или Motor_AutoManual (для DH-485)
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Для конфигурирования состояний индикатора MODE:

1. Щелкните закладку States диалогового окна Multistate Indicator.

2. Удалите состояния 2 и 3. Эти состояния не используются.

• щелкните строку с номером 2.

• нажмите левую кнопку мыши и перетаскивайте мышь до тех пор, пока строки
2 и 3 не будут выделены.

• Щелкните правой кнопкой мыши и выберите Delete State в контекстном меню.

3. Отредактируйте поля для состояния 0 (строка 0) следующим образом:

• В поле Text замените ST 0 на AUTO.

• В поле Text Size выделите 16x24 в окне списка. Не изменяйте текстовый
размер для приложений PV550.

Выделите следующие цвета состояния 0 (строка 0).

• Yellow для Object Background

• Blue для Object Foreground

• Yellow для Text Background

• Cyan для Text Foreground

4. Отредактируйте поля состояния 1 (строка 1) следующим образом:

• В поле Text замените ST 1 на MANUAL.

• В поле Text Size выделите 16x24 в окне списка. Не изменяйте текстовый
размер для приложений PV550.

Выделите следующие цвета состояния 1 (строка 1).

• Yellow для Object Background

• Black для Object Foreground

• Yellow для Text Background

• Cyan для Text Foreground

5. Щелкните OK для выхода из диалогового окна.

Звездочка (*) появляется, если размер текста превышает размер объекта.

6. Промасштабируйте объект, если это необходимо для соответствия с текстом.

Для цветных

Для цветных



Создание примера приложения

4-20

Для создания заголовка MODE для индикатора MODE:

Заголовок

1. В подменю Objects > Graphics выберите Text.

2. Разместите указатель (+) над индикатором, нажмите левую кнопку мыши и
перетащите указатель для масштабирования текстового блока.

3. В окне Text введите MODE.

Не беспокойтесь, если этот номер другой

4. Щелкните  на панели форматирования, чтобы подчеркнуть текст.

5. Щелкните  на панели форматирования и выберите 16x24. Не изменяйте

текстовый размер для приложений PV550.

• Выберите Black в меню Format > Foreground Color.

• Выберите Yellow в меню Format > Background Color.

6. Щелкните правой кнопкой мыши для выхода из режима текста.

7. Щелкните  для выхода из режима внутреннего текста.

8. Промасштабируйте текстовый блок, если это необходимо для соответствия с
текстом.

Для цветных
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Создание индикатора Status

Индикатор Status

Для создания индикатора STATUS:

1. Выделите индикатор MODE и его заголовок. Нажмите клавишу Shift и щелкните
объект индикатора Mode и заголовок.

На обоих объектах появятся манипуляторы.

2. Щелкните инструмент Copy  .

3. Щелкните инструмент Paste  .

4. Переместите контур вправо от индикатора MODE и щелкните левой кнопкой мыши
для вклеивания объектов.

5. Отмените выделение объектов, щелкнув в любом месте вне рамки.
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Для настройки свойств индикатора STATUS:

1. Дважды щелкните слово AUTO вклеенного индикатора для открытия его
диалогового окна.

Вклеенный индикатор

2. Настройте свойства, как показано ниже.

Щелкните Single Bit

Введите Motor_Stop_Ind

Для конфигурирования состояний индикатора STATUS:

1. Щелкните закладку States диалогового окна Multistate Indicator.

2. В поле Text состояния 0 замените AUTO на START.

Выделите цвета для состояния 0 (строка 0):

• Yellow для Object Background

• Green для Object Foreground

• Yellow для Text Background

• Green для Text Foreground

Для цветных
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3. В поле Text состояния 1 замените MANUAL на STOP.

Выделите цвета для состояния 1 (строка 1):

• Yellow для Object Background

• Blue для Object Foreground

• Yellow для Text Background

• Light Red для Text Foreground

4. Щелкните OK для закрытия диалогового окна.

Звездочка (*) появляется, если размер текста превышает размер объекта.

5. Промасштабируйте объект, если это необходимо для соответствия с текстом.

Для создания заголовка STATUS для индикатора:

1. Выделите вклеенный заголовок.

Вклеенный заголовок

2. Щелкните инструмент Inner Text  .

3. В окне Text замените MODE на STATUS.

Не беспокойтесь, если этот номер другой

4. Щелкните  для выхода из режима внутреннего текста.

5. Промасштабируйте текстовый блок, если это необходимо для соответствия с
текстом.

Для цветных
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Для создания MOTOR STATUS над индикаторным окном:

1. В подменю Objects > Graphics выберите Text.

2. Разместите указатель (+) над индикаторным окном, нажмите левую кнопку мыши и
перетащите указатель для масштабирования текстового блока.

3. В окне Text введите MOTOR STATUS.

Не беспокойтесь, если этот номер другой

4. Щелкните  на панели форматирования и выберите 16x24. Не изменяйте

текстовый размер для приложений PV550.

• Выберите Yellow в подменю Format > Foreground Color.

• Выберите Black в подменю Format > Background Color.

5. Щелкните правой кнопкой мыши для выхода из режима объекта текста.

6. Щелкните  для выхода из режима внутреннего текста.

7. Промасштабируйте текстовый блок, если это необходимо.

Закрытие экрана Motor Status

Для закрытия экрана MOTOR STATUS:

Выберите Close в меню Screen.

Или дважды щелкните окно меню управления на экране.

Окно меню управления

Окно Application File сейчас показывает 1 экран.

Для цветных
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Создание экрана Motor Speed

Этот раздел показывает как создать экран MOTOR SPEED.

Алгоритмы этого раздела показывают, как:

• открыть окно инструментов и палитру цветов

• открыть новый экран

• создать кратковременную кнопку для увеличения скорости двигателя

• создать кратковременную кнопку для уменьшения скорости двигателя

• создать экранную кнопку для возврата к экрану Motor Status

• создать столбиковую диаграмму для показа текущей скорости в графической
форме

• создать объект числового ввода для ввода скорости двигателя

• создать дисплей числовых данных для показа текущей скорости

• связать экран  Motor Speed с экраном Motor Status

• закрыть экран Motor Speed

Открытие окна инструментов и палитры цветов

При создании экрана MOTOR SPEED объекты выделяются в окне инструментов, а
некоторые цвета выделяются в палитре цветов (для цветных терминалов).

Для открытия окна инструментов и палитры цветов:

Выберите Toolbox, а затем Color Palette в меню View.

Перемещайте Toolbox или Palette, щелкая заголовок
и перетаскивая окно в новое местоположение

Используйте верхнюю строку для
выделения цветов переднего плана

View Box обновляется по мере выделения
цветов переднего и заднего плана

Используйте нижнюю строку для выделения цветов заднего плана
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Открытие нового экрана

Для создания окна приложения MOTOR SPEED:

1. Выберите New в меню Screen или щелкните 

2. Введите MOTOR SPEED в окне Name диалогового окна.

3. Щелкните OK для закрытия диалогового окна и открытия экрана 2.

Создание кнопки Increase Speed

Для создания кнопки Increase Speed:

1. Щелкните инструмент Momentary Push Button  в окне инструментов.

2. Разместите указатель (+) в нижнем левом углу экрана, щелкните левой кнопкой
мыши и перетащите указатель горизонтально для масштабирования кнопки.

3. Щелкните правой кнопкой мыши для выхода из режима кнопки.

Или щелкните инструмент выделения  в окне инструментов.

Для настройки свойств кнопки:

1. Дважды щелкните кнопку для открытия ее диалогового окна.

2. Настройте свойства, как показано ниже.

Щелкните Single Bit

Выделите F1

Введите Motor_Speed_Inc
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Для конфигурирования состояний кнопки Increase Speed:

1. Щелкните закладку States диалогового окна Push Buttons.

2. Отредактируйте поля состояния 0 (строка 0) следующим образом:

• В поле Text замените ST 0 на /*R*/ INC SPD/*R*/F1

• В поле Text Size выделите 16x24 в окне списка. Не изменяйте текстовый
размер для приложений PV550.

Выделите следующие цвета для состояния 0 (строка 0).

• Cyan для Object Background

• White для Object Foreground

• Cyan для Text Background

• White для Text Foreground

3. В поле Text состояния 1 замените ST 1 на /*R*/INC.

Выделите следующие цвета для состояния 1 (строка 1).

• White для Object Background

• Cyan для Object Foreground

• White для Text Background

• Cyan для Text Foreground

4. Щелкните OK для выхода из диалогового окна.

Звездочка (*) появляется, если размер текста превышает размер объекта.

5. Промасштабируйте объект, если это необходимо для соответствия с текстом.

INC SPD
F1

Состояние 0

INC

Состояние 1

Для цветных

Для цветных
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Создание кнопки Decrease Speed

Для создания кнопки Decrease Speed:

1. Выделите INC  SPD
F1  (если не выделена).

2. Щелкните инструмент Copy .

3. Щелкните инструмент Paste .

4. Переместите контур объекта вправо и щелкните левой кнопкой мыши для
вклеивания объекта.

Для настройки свойств кнопки Decrease Speed:

1. Дважды щелкните вклеенный объект для открытия его диалогового окна.

2. Настройте свойства, как показано ниже.

Выделите F2

Введите Motor_Speed_Dec
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Для конфигурирования состояний скопированной кнопки:

1. Щелкните закладку States диалогового окна Push Buttons.

2. В поле Text состояния 0 замените /*R*/INC SPD/*R*/F1 на /*R*/DEC SPD/*R*/F2

3. В поле Text состояния 1 замените /*R*/INC на /*R*/DEC

4. Щелкните OK для закрытия диалогового окна.

Создание экранной кнопки Motor Status

Следующий алгоритм использует функции Copy и Paste для копирования кнопки
MOTOR SPEED с экрана MOTOR STATUS на экран MOTOR SPEED.

1. В меню Window выберите Getting Started для активизации окна Application File.

2. Дважды щелкните MOTOR STATUS для открытия окна 1.

3. Выберите 
MOTOR
SPEED

F8
 на экране Motor Status.

DEC SPD
F2

Состояние 0

DEC

Состояние 1
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4. Щелкните инструмент Copy .

5. Дважды щелкните окно меню управления экрана 1 или выберите Close в меню
Screen для закрытия экрана.

Окно меню управления

6. Активизируйте экран 2, щелкнув заголовок экрана или выбрав MOTOR SPEED в
меню Window.

7. Щелкните инструмент Paste .

8. Переместите контур в нижний правый угол экрана и щелкните левой кнопкой
мыши.

Для изменения внутреннего текста скопированной экранной кнопки:

1. Щелкните инструмент Inner Text .

2. Замените MOTOR SPEED F8 на MOTOR STATUS F8.

Не беспокойтесь, если этот номер другой
Клавиша Enter нажималась дважды

3. Щелкните  для выхода из режима внутреннего текста.

Для изменения свойств скопированной экранной кнопки:

1. Дважды щелкните объект для открытия его диалогового окна.

2. Настройте свойства, как показано ниже.

Выделите Motor Speed

Выделите F8 для терминалов PV900/PV1400
Выделите F5 для терминалов PV550/PV600

3. Щелкните OK для закрытия диалогового окна.
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Создание столбиковой диаграммы и шкалы Speed

Для создания столбиковой диаграммы:

1. Щелкните инструмент Bar Graph  в окне инструментов.

2. Разместите указатель (+), нажмите левую кнопку мыши и перетащите указатель
для масштабирования столбиковой диаграммы.

3. Щелкните правой кнопкой мыши или  в окне инструментов для выхода из
режима столбиковой диаграммы.

4. В меню Format > Fill Pattern выберите Cross Hatch.

Или щелкните  на панели форматирования и выберите Cross Hatch.

• Выделите Light Red в верхней строке палитры цветов.

• Выделите White в нижней строке палитры цветов.

Light Red – цвет переднего плана

White – цвет заднего плана

Для цветных
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Для настройки свойств столбиковой диаграммы:

1. Дважды щелкните объект столбиковой диаграммы.

2. Настройте свойства, как показано ниже:

Введите 1000

Введите Motor_Speed_Ind

3. Щелкните OK для закрытия диалогового окна.

Для создания шкалы столбиковой диаграммы:

1. Щелкните инструмент Scale  в окне инструментов.

2. Разместите указатель (+) выше и левее столбиковой диаграммы, нажмите левую
кнопку мыши и перетащите указатель для масштабирования шкалы.

3. Щелкните правой кнопкой мыши или  для выхода из режима шкалы.

Выделите Light Red в верхней строке палитры цветов.

Для выделения количества штрихов шкалы:

1. Дважды щелкните объект шкалы для открытия его диалогового окна.

2. Щелкните в окне Number и введите 11.

Введите 11

3. Щелкните OK для закрытия диалогового окна.

Для цветных
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Для создания меток штрихов (1000, 0):

1. Щелкните инструмент Text  в окне инструментов.

2. Разместите указатель (+) слева от верхнего штриха, щелкните левой кнопкой
мыши и перетащите указатель для масштабирования текстового блока.

3. Введите 1000 в окне Text.

Не беспокойтесь, если этот номер другой

4. Щелкните  на панели форматирования и выберите 16x24. Не изменяйте

текстовый размер для приложений PV550.

5. Выберите Right в меню Format > Align Text или щелкните .

• Выделите Light Red в верхней строке палитры цветов.

• Выделите Black в нижней строке палитры цветов.

Light Red – цвет переднего плана

Black – цвет заднего плана

6. Щелкните  для выхода из режима внутреннего текста.

7. Щелкните правой кнопкой мыши или  для выхода из режима текста.

8. По необходимости промасштабируйте текстовый объект.

9. Щелкните инструмент Copy , а затем инструмент Paste .

Переместите контур текстового блока к нижней части шкалы.

10. Щелкните  для входа в режим внутреннего текста.

11. Замените 1000 на 0 в окне Text, а затем щелкните  для выхода из режима

внутреннего текста.

Для цветных
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Для создания заголовка Motor Speed над столбиковой диаграммой:

1. Щелкните  в окне инструментов.

2. Разместите указатель (+) над столбиковой диаграммой и перетащите указатель
для масштабирования текстового блока.

3. Введите Motor Speed в окне Text.

4. Щелкните  на панели форматирования и выберите 16x24. Не изменяйте

текстовый размер для приложений PV550.

• Выделите White в верхней строке палитры цветов.

• Выделите Black в нижней строке палитры цветов.

White – цвет переднего плана

Black – цвет заднего плана

5. Щелкните  для выхода из режима внутреннего текста.

6. Щелкните правой кнопкой мыши или  для выхода из режима текста.

7. По необходимости промасштабируйте объект текста.

Создание объекта числового ввода Speed

Объект числового ввода Speed

Для создания объекта числового ввода Speed:

1. Щелкните инструмент Cursor Point  в окне инструментов.

2. Разместите указатель (+), нажмите левую кнопку мыши и перетащите указатель
для масштабирования объекта.

Объект создается с 6 числовыми метками-заполнителями.

3. Щелкните  для входа в режим внутреннего текста.

Для цветных
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4. Щелкните  и выберите 16x24. Не изменяйте текстовый размер для

приложений PV550.

• Выделите Light Cyan в верхней строке палитры цветов.

• Выделите Magenta в нижней строке палитры цветов.

Light Cyan – цвет переднего плана Magenta – цвет заднего плана

5. Осуществите выход из режима внутреннего текста.

6. Щелкните правой кнопкой мыши или  для выхода из режима выделения
курсора.

• Выделите Light Magenta в верхней строке палитры цветов.

• Выделите Magenta в нижней строке палитры цветов.

Light Magenta – цвет переднего плана Magenta – цвет заднего плана

Для настройки свойств объекта числового ввода Speed:

1. Дважды щелкните объект числового ввода для открытия его диалогового окна.

2. Настройте свойства, как показано ниже.

Выделите 4

Введите Motor_Speed

Введите Motor_Spd_Notify
(только для Remote I/O)

Введите Motor_Spd_Handshk
(только для Remote I/O)

Введите
Motor_Speed_Ind

3. Щелкните OK для закрытия диалогового окна.

Теперь объект имеет 4 числовых метки-заполнителя ####.

Для цветных

Для цветных
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Для создания заголовка ENTER SPEED:

1. Щелкните  в окне инструментов.

2. Разместите указатель (+) над объектом числового ввода, нажмите левую кнопку
мыши, перетащите указатель для масштабирования текстового блока.

3. В окне Text введите ENTER SPEED.

Не беспокойтесь, если этот номер другой

4. Щелкните  и выберите 16x24.

• Выделите Light Magenta в верхней строке палитры цветов.

• Выделите Black в нижней строке палитры цветов.

5. Щелкните  для выхода из режима внутреннего текста.

6. Щелкните правой кнопкой мыши или  для выхода из режима объекта
текста.

7. При необходимости промасштабируйте текстовый блок для соответствия с
текстом.

Для создания описательной метки RPM:

1. Щелкните  в окне инструментов.

2. Разместите указатель (+) справа от объекта числового ввода, нажмите левую
кнопку мыши, перетащите указатель для масштабирования текстового блока.

3. В окне Text введите RPM.

Не беспокойтесь, если этот номер другой

4. Щелкните  и измените текстовый размер на 16x24. Не изменяйте текстовый

размер для приложений PV550.

• Выделите Light Cyan в верхней строке палитры цветов.

• Выделите Black в нижней строке палитры цветов.

Для цветных

Для цветных
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5. Щелкните  для выхода из режима внутреннего цвета.

6. Щелкните правой кнопкой мыши или  для выхода из режима объекта
текста.

7. При необходимости промасштабируйте текстовый блок.

Создание дисплея данных RPM

Дисплей числовых данных

Для создания дисплея данных RPM:

1. Щелкните инструмент Numeric Data Display  в окне инструментов.

2. Разместите указатель (+), нажмите левую кнопку мыши и перетащите указатель
для масштабирования объекта.

Объект создается с 6 числовыми метками-заполнителями.

3. Щелкните  для входа в режим внутреннего текста.

4. Щелкните  и измените текстовый размер на 16x24. Не изменяйте текстовый

размер для приложений PV550.

• Выделите Light Red в верхней строке палитры цветов.

• Выделите Black в нижней строке палитры цветов.

5. Щелкните  для выхода из режима внутреннего текста.

6. Щелкните правой кнопкой мыши или  для выхода из режима дисплея
данных.

Для цветных
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Для настройки свойств дисплея данных RPM:

1. Дважды щелкните объект дисплея числовых данных для открытия его диалогового
окна.

2. Настройте свойства, как показано ниже:

Выделите 4 для Field Width

Введите Motor_Speed_Ind

3. Щелкните OK для закрытия диалогового окна.

Теперь объект имеет 4 числовых метки-заполнителя ####.

Для создания метки  дисплея числовых данных:

1. Выделите текстовый блок RPM справа от объекта числового ввода.

2. Щелкните инструмент Copy  .

3. Щелкните инструмент Paste  .

4. Переместите контур вправо от дисплея числовых данных и щелкните левой
кнопкой мыши.

5. На монохромных терминалах щелкните инструмент Toggle Fore/Background 

на панели форматирования.

• Выделите Light Red в верхней строке палитры цветов.Для цветных
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Закрытие окна инструментов и палитры цветов

Для закрытия окна инструментов и палитры цветов:

Выберите ToolBox, а затем Color Palette в меню View.

Или дважды щелкните окно меню управления в верхнем левом углу каждого окна.

Закрытие экрана Motor Speed

Для закрытия экрана MOTOR SPEED:

Выберите Close в меню Screen.

Или дважды щелкните окно меню управления этого экрана.

Окно меню управления

Теперь окно Application File показывает 2 экрана.

Связывание экранов Motor Speed и Motor Status

Для связывания экрана Motor Speed с экраном Motor Status:

1. Дважды щелкните Motor Status для открытия экрана.

2. Дважды щелкните экранную кнопку Motor Speed для открытия ее диалогового
окна.

3. Настройте свойства, как показано ниже:

Выделите Motor Speed

Выделите F8 для терминалов PV900 / PV1400
Выделите F5 для терминалов PV600

4. Щелкните OK для закрытия диалогового окна.

5. Выберите Close в меню Screen для закрытия экрана Motor Status.
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Создание сигналов тревоги

Этот раздел показывает, как создавать сигналы тревоги для приложений, созданных с
помощью PanelBuilder Software версии V2.0 (или более поздней).

Алгоритмы показывают, как создать Alarm Banner, которое появляется поверх экрана
приложения при инициализации сигнала тревоги. Это сообщение включает:

• Message Display для показа сообщения сигнала тревоги

• Кнопку Ack, позволяющую оператору подтвердить сигнал тревоги

• Кнопку Clear, позволяющую оператору удалить сообщение с экрана

Alarm Banner – это глобальный дисплей, который используется всеми экранами в
приложении.

Для создания Alarm Banner:

1. Выберите Create Alarm Banner в меню Screen.

Сообщение дисплея сообщений 
сигналов тревоги не появляется 
до тех пор, пока вы не 
сконфигурируете сообщения 
сигналов тревоги

2. Сконфигурируйте кнопку сигналов тревоги Clear.

• Щелкните вне Alarm Banner, затем выделите кнопку Clear и переместите ее
влево от сообщения, как показано ниже.

• Дважды щелкните кнопку Clear для открытия ее диалогового окна. Выделите
функциональную клавишу F4, а затем щелкните OK для закрытия диалогового
окна.

• Щелкните  для входа в режим внутреннего текста, добавьте F4 (нажмите

Enter после Clear, затем введите F4) в текст, затем осуществите выход из
режима внутреннего текста.
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3. Создайте кнопку сигнала тревоги Ack.

• Выберите Acknowledge в подменю Objects > Alarm Buttons.

•  Разместите указатель (+) с правой стороны сообщения. Щелкните левой
кнопкой мыши, чтобы поместить кнопку Ack, как показано ниже.

• Щелкните правой кнопкой мыши для выхода из режима кнопки Ack.

• Дважды щелкните кнопку Ack для открытия ее диалогового окна. Выделите
функциональную клавишу F7, а затем щелкните OK для закрытия диалогового
окна.

• Войдите в режим внутреннего текста, добавьте F7 (нажмите Enter после Ack,
затем введите F7) в текст, затем осуществите выход из режима внутреннего
текста.

Сообщение не появляется в 
дисплее до тех пор, пока вы не 
сконфигурируете сообщения 
сигналов тревоги

Для определения инициализатора сигнала тревоги:

1. Дважды щелкните Alarm Message Display в Alarm Banner.

Или выберите Alarm Setup в меню Application.

Откроется диалоговое окно Alarm Setup.

2. Щелкните закладку Alarm Triggers.

Введите Messages Выделите Value

3. Щелкните в поле Trigger Tag и введите Messages.

4. Щелкните в поле Trigger Type и выделите Value в списке.
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Для определения сообщений сигналов тревоги:

1. Щелкните закладку Alarm.

Откроется таблица. Каждая строка представляет сообщение сигнала тревоги.

Используйте горизонтальную линейку прокрутки
для просмотра остальных полей

1. Отредактируйте следующие поля для сообщения сигнала тревоги 1 (строка 1):

• В поле Text введите SPEED TOO HIGH.

• В поле Value / Bit введите 950.

• В поле Trigger выделите Messages.

• В поле ACK выделите опцию.

2. Щелкните правой кнопкой мыши и выберите Append Alarm в контекстном меню.
Добавляется новая строка со значениями по умолчанию строки 1.

3. Отредактируйте следующие поля для сообщения сигнала тревоги 2 (строка 2):

• В поле Text введите MOTOR SPEED TOO LOW.

• В поле Value / Bit введите 50.

• Проверьте, что опция поля ACK выделена.

4. Щелкните в строке 1 для отображения этого сообщения на дисплее.

5. Щелкните OK для выхода из диалогового окна Alarm Setup.

Для закрытия Alarm Banner:

Выберите Close в меню Screen.

Или дважды щелкните окно меню управления экрана.

Теперь окно Application File показывает Alarm Banner и два экрана.
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Сохранение приложения

Для сохранения файла приложения:

1. Выберите Save в меню File.

Или щелкните  на панели инструментов.

Откроется диалоговое окно Save As. Окно File Name показывает 8 первых символов
имени приложения с типом файла .pba (по умолчанию).

Если приложение было сохранено ранее, диалоговое окно Save As не будет
открываться. Приложение будет автоматически сохраняться под именем, введенным
ранее в диалоговом окне Save As.

2. Введите gtstart.pba в окне File Name.

3. Щелкните кнопку OK.

Файл GTSTART.PBA сохраняется в папке C:\AB\PBWIN. PanelBuilder добавляет
расширение .PBA.

Заключение

Вы только что закончили создание экранов для начала работы с приложением.

Следующая глава покажет, как настроить параметры связи включения и выполнения
для терминала PanelView.
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5 Настройка терминала PanelView

Задачи главы

Эта глава показывает, как определить опции включения и параметры связи
выполнения для терминала PanelView.

При определении параметров связи обращайтесь к соответствующему разделу (DH-
485, Remote I/O или DH+) в зависимости от используемого вами типа терминала.

ëåäçàÐ .ðòÑ

O/IetomeRèçÿâñêåîðòñàíåèíåëåäåðïÎ 2-5

584-HDèçÿâñêåîðòñàíåèíåëåäåðïÎ 4-5

+HDèçÿâñêåîðòñàíåèíåëåäåðïÎ 5-5

àëàíèìðåòÿèíå÷þëêâéèöïîàêéîðòñàÍ 6-5

ÿèíåæîëèðïåèíåíàðõîÑ 6-5
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Определение настроек связи Remote I/O

Этот раздел показывает, как определять параметры связи выполнения для версии
Remote I/O терминала PanelView.

Переходите к стр. 5-4 для определения параметров связи выполнения для терминалов
DH-485 или RS-232. Переходите к стр. 5-5 для определения параметров связи
выполнения для терминала DH+.

Для конфигурирования связей Remote I/O:

1. Выберите Terminal Setup в меню Application.

2. Выделите закладку Setup.

Диалоговое окно покажет имя и тип терминала PanelView 900, определенного для
приложения. Диалоговое окно будет похоже на терминал PanelView 550.

Имя терминала было определено при создании приложения.

3. Щелкните  на закладке Setup.

Откроется диалоговое окно Remote I/O Communication Setup.

4. Настройте параметры, как показано ниже:

Диалоговое окно Remote I/O Communications

Имя терминала с закладки Setup

Выделите PLC 5/25

Выделите 1
Выделите все опции

Выделите 57600
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Для настройки блочной передачи для связей Remote I/O:

1. Щелкните кнопку Block Transfer.

Откроется диалоговое окно Block Transfer.

Block Transfer 1 назначена

Block Transfer 2 назначена

Пометьте опцию Pass Through Выделите 0

2. Введите данные для 2 блочных передач, показанных выше.

Для Block Transfer 1:

– Пометьте опцию Enabled

– Введите N7:0 в поле Address

– Выделите W (для Write) в окне Mode

– Выделите 10 в окне Length

Для Block Transfer 2:

– Пометьте опцию Enabled

– Введите N7:10 в поле Address

– Выделите R (для Read) в окне Mode

– Выделите 10 в окне Length

3. Пометьте опцию Pass Trough.

4. Выделите 0 в окне Block Transfer Timeout.

5. Щелкните OK для возврата к диалоговому окну Communication Setup.

6. Щелкните OK для возврата к диалоговому окну Terminal Setup.

Переходите к стр. 5-6 для настройки Terminal Power-Up Options.
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Определение настроек связи DH-485

Этот раздел показывает, как определять параметры связи выполнения DH-485 для
версии DH-485 (или RS-232) терминала PanelView.

Для конфигурирования связей DH-485:

1. Выберите Terminal Setup в меню Application.

2. Выделите закладку Setup.

Диалоговое окно покажет имя и тип терминала PanelView 900, определенного для
приложения. Диалоговое окно будет похоже на терминал PanelView.

Имя терминала было определено при создании приложения.

3. Щелкните  на закладке Setup.

Откроется диалоговое окно DH-485 Communication Setup для терминала.

4. Настройте параметры, как показано ниже:

Диалоговое окно DH-485 Communications

Имя терминала с закладки Setup

Выделите 2

Выделите 31

Введите SLC_1

Выделите 19200

Выделите 1

5. Щелкните кнопку Apply.

6. Щелкните OK для возврата к диалоговому окну Terminal Setup.

7. Щелкните OK для закрытия диалогового окна Terminal Setup.
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Определение настроек связи DH+

Этот раздел показывает, как определить параметры связи выполнения для версии DH+
терминала PanelView.

Для конфигурирования связей DH+:

1. Выберите Terminal Setup в меню Application.

2. Выделите закладку Setup.

Диалоговое окно покажет имя и тип терминала PanelView 900, определенного для
приложения. Диалоговое окно будет похоже на терминал PanelView.

Имя терминала было определено при создании приложения.

3. Щелкните  на закладке Setup.

Диалоговое окно DH+ Communication Setup откроется для терминала.

4. Настройте параметры, как показано ниже:

Диалоговое окно DH+ Communications

Имя терминала с закладки Setup

Выделите 2

Выделите 57600

Введите SLC_1

Выделите 19200

Выделите 1
Примечание: SLC_1 вводится для 
соответствия с именем узла в 
проекте GS (базе тегов)

SLC_1

5. Щелкните кнопку Apply.

6. Щелкните OK для возврата к диалоговому окну Terminal Setup.

7. Щелкните OK для закрытия диалогового окна Terminal Setup.
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Настройка опций включения терминала

Для настройки опций включения для терминала PanelView:

1. Выберите Terminal Setup в меню Application.

2. В диалоговом окне Terminal Setup выделите закладку Power-Up.

Выделите Motor Status

3. Проверьте, что Motor Status выделен в окне Startup Screen.

4. Щелкните кнопку OK.

Сохранение приложения

Для сохранения изменений в приложении:

Щелкните  на панели инструментов.

Заключение

Вы только что определили настройки включения и параметры связей выполнения для
терминала PanelView.

Следующая глава покажет вам, как вводить теги приложения.
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6 Ввод тегов приложения

Задачи главы

Эта глава содержит следующие разделы:

ëåäçàÐ .ðòÑ

rotidEgaTåèòûðêòÎ 1-6

âîãåòðîçáÎ 2-6

âîãåòäîâÂ 3-6

rotidEgaTçèäîõûÂ 5-6

ûìðîôàäèâåèíàâîçüëîïñÈ 6-6

Открытие Tag Editor

Этот раздел показывает, как открыть Tag Editor для ввода, просмотра или
редактирования тегов для приложения.

Для открытия редактора тегов:

В меню Application выберите Tag Editor.

Tag Editor открывается и показывает табличный вид редактора.

Имя проекта Кнопка максимального окна

Столбец статуса

Показывает карандаш, если вы 
редактируете строку, или X, если 
строка имеет ошибку

Щелкните кнопку максимального окна для распахивания окна во весь экран.
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Обзор тегов

Следующая таблица перечисляет данные тегов для:

• Приложений DH-485 / DH+, взаимодействующих с контроллером SLC или PLC.
Данные тегов одинаковы для этих приложений.

Для приложений DH+, взаимодействующих с PLC, правильным будет оставить
SLC_1 в поле Node Name.

• Приложения Remote I/O, взаимодействующего с контроллером PLC.

Обращайтесь к соответствующей таблице при вводе тегов в следующем разделе.

)SGòêåîðï(detratSgnitteG+HDèëè584-HDÿèíåæîëèðïÿëäèãåÒ

àãåòÿìÈ õûííàäïèÒ åèíàñèïÎ
àëçóÿìÈ 1

)ðåëëîðòíîK(
ñåðäÀ

àãåò
åîíüëà÷àÍ

åèíå÷àíç
àòîòñà×

ÿèíåëâîíáî

segasseM regetnIdengisnU
àëàíãèñåèíåùáîîñòåàæàðáîòÎ

.èãîâåðò
1_CLS 3:7N 0 1

launaMotuA_rotoM regetnIdengisnU
/éèêñå÷èòàìîòâàòåàâûçàêîÏ

.ÿëåòàãèâäìèæåðéîí÷óð
1_CLS 0:7N 0 1

deepS_rotoM regetnIdengisnU .ÿëåòàãèâäþüòñîðîêñòåÿëâàðïÓ 1_CLS 1:7N 0 1

ceD_deepS_rotoM tiB .ÿëåòàãèâäüòñîðîêñòåàøüíåìÓ 1_CLS 3/0:3B 0 1

cnI_deepS_rotoM tiB .ÿëåòàãèâäüòñîðîêñòåàâè÷èëåâÓ 1_CLS 2/0:3B 0 1

dnI_deepS_rotoM regetnIdengisnU .ÿëåòàãèâäüòñîðîêñòåàâûçàêîÏ 1_CLS 2:7N 0 1

tratS_rotoM tiB .üëåòàãèâäòåàêñóïàÇ 1_CLS 0/0:3B 0 1

dnI_tratS_rotoM tiB .ÿëåòàãèâäêñóïàçòåàâûçàêîÏ 1_CLS 4/0:3B 0 1

potS_rotoM tiB .üëåòàãèâäòåàâèëâàíàòñÎ 1_CLS 1/0:3B 0 1

dnI_potS_rotoM tiB .ÿëåòàãèâäâîíàòñîòåàâûçàêîÏ 1_CLS 5/0:3B 0 1

)OIRSGòêåîðï(detratSgnitteGO/IetomeRÿèíåæîëèðïÿëäèãåÒ

àãåòÿìÈ õûííàäïèÒ åèíàñèïÎ
àëçóÿìÈ

)ðåëëîðòíîK(
àãåòñåðäÀ

åîíüëà÷àÍ
åèíå÷àíç

àòîòñà×
ÿèíåëâîíáî

segasseM regetnIdengisnU
àëàíãèñåèíåùáîîñòåàæàðáîòÎ

.èãîâåðò
OIR_CLP 4:7N 0 1

launaMotuA_rotoM regetnIdengisnU
/éèêñå÷èòàìîòâàòåàâûçàêîÏ

.ÿëåòàãèâäìèæåðéîí÷óð
OIR_CLP 01:7N 0 1

dnI_naMotuA_rotoM regetnIdengisnU
ñóòàòñòåàâûçàêîÏ

îãîí÷óð/îãîêñå÷èòàìîòâà
.ÿëåòàãèâäàìèæåð

OIR_CLP 3:7N 0 1

khsdnaH_dpS_rotoM tiB .ÿëåòàãèâäüòñîðîêñòåóðèòèâK OIR_CLP 2/2:7N 0 1

yfitoN_dpS_rotoM tiB
èòñîðîêñîòåÿëìîäåâñÎ

.ÿëåòàãèâä
OIR_CLP 4/11:7N 0 1

deepS_rotoM regetnIdengisnU .ÿëåòàãèâäþüòñîðîêñòåÿëâàðïÓ OIR_CLP 31:7N 0 1

ceD_deepS_rotoM tiB .ÿëåòàãèâäüòñîðîêñòåàøüíåìÓ OIR_CLP 0/11:7N 0 1

cnI_deepS_rotoM tiB .ÿëåòàãèâäüòñîðîêñòåàâè÷èëåâÓ OIR_CLP 1/11:7N 0 1

dnI_deepS_rotoM regetnIdengisnU .ÿëåòàãèâäüòñîðîêñòåàâûçàêîÏ OIR_CLP 1:7N 0 1

tratS_rotoM tiB .üëåòàãèâäòåàêñóïàÇ OIR_CLP 01/010:I 0 1

dnI_tratS_rotoM tiB .ÿëåòàãèâäêñóïàçòåàâûçàêîÏ OIR_CLP 01/010:O 0 1

potS_rotoM tiB .üëåòàãèâäòåàâèëâàíàòñÎ OIR_CLP 11/010:I 0 1

dnI_potS_rotoM tiB .ÿëåòàãèâäâîíàòñîòåàâûçàêîÏ OIR_CLP 11/010:O 0 1
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Ввод тегов

Следуйте одинаковым основным алгоритмам для ввода тегов приложения.

Для ввода тега приложения Messages:

1. Щелкните в поле Tag Name и введите Messages.

Эта пиктограмма указывает на
строку, которую вы редактируете

2. Переместитесь к полю Data Type

Переместите указатель мыши к полю Data Type и щелкните левой кнопкой мыши
или нажмите клавишу Tab.

3. Щелкните стрелку в окне Data Type для открытия списка опций и щелкните
Unsigned Integer.

4. Переместитесь к полю Description и введите «Display alarm messages».

5. Переместитесь к полю Node Name и введите «PLC_RIO» для приложения Remote I/
O, «SLC_1» для приложения DH-485 или DH+.

6. Переместитесь к полю Address и введите N7:4 для приложения Remote I/O или
N7:3 для приложения DH-485 или DH+.

7. Переместитесь к полю Initial Value и введите 0.
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8. Щелкните стрелку в окне Update Frequency для открытия списка опций и
щелкните 1.

9. Сохраните определение тега:

Нажатием Enter.

Или перемещением курсора к полю Tag Name следующей строки.

Или двойным щелчком в окне Status Column этого тега.

Повторите этапы 1 – 10 для создания остальных тегов. Введите данные,
показанные в соответствующей таблице на стр. 6-2.

Ниже показано, как выглядит Tag Editor после ввода тегов.

Проект GSRIO – Теги Remote I/O для PLC
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Проект GS – Теги DH-485 / DH+ для SLC или PLC

Выход из Tag Editor

Для выхода из редактора тегов:

В меню Project выберите Exit.

Вы вернетесь к рабочему пространству PanelBuilder.
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Использование вида формы

Второй способ ввода тегов состоит в использовании вида формы Tag Editor. Вы
можете обращаться к виду формы из диалогового окна объекта при создании
приложения или из Tag Editor.

Для получения более подробной информации об использовании вида формы см.
Руководство пользователя PanelBuilder (публикация 2711-6.0).

Дважды щелкните объект для открытия
диалогового окна Numeric Data Display

Параметры Scaling и Data Entry Limit доступны
только в Form View (виде формы) конкретного объекта

Открывает
Form View
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7 Проверка и загрузка приложения

Задачи главы

Эта глава содержит следующие разделы:

ëåäçàÐ .ðòÑ

ÿèíåæîëèðïàêðåâîðÏ 1-7

ÿèíåæîëèðïàêçóðãàÇ 2-7

ÿèíåæîëèðïåèòûðêàÇ 4-7

Проверка приложения

Этот раздел показывает как проверить приложение на наличие ошибок.

Для проверки примера приложения:

1. В меню Application выберите Validate All.

Следующее диалоговое окно откроется, когда приложение пройдет проверку.

2. Щелкните OK.

Если приложение не прошло проверку, откроется диалоговое окно Exceptions,
перечисляющее все найденные ошибки. Вы должны исправить ошибки, а затем
повторно проверить приложение. Предупреждения не требуют исправления.

Щелкните для закрытия
диалогового окна

Для получения более подробной информации о том, как исправлять ошибки, и о
значениях ошибок см. руководство пользователя PanelBuilder Software (публикация
2711-6.0).
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Загрузка приложения

Этот раздел показывает, как загрузить пример приложения с вашего компьютера на
терминал PanelView с использованием последовательной связи.

• проверьте подсоединения кабелей (см. главу 2).

• используйте внутренний драйвер DF1 для загрузки приложений на терминалы
Remote I/O, DH+ и RS-232 (с портом RS-232 / DF1).

• используёте внутренний драйвер DH485 для загрузки приложений на терминалы
DH-485. Драйвер DH485 требует Windows 95.

Для использования внутренних драйверов драйверы INTERCHANGE должны быть
запрещены. Осуществите выход из Windows и введите ABICSTOP после
приглашения DOS.

Для загрузки приложения с использованием внутреннего драйвера DF1:

1 Откройте приложение, которое вы хотите загрузить

2 Выберите Download в меню Application

3 Выделите параметры Download

4 Приложение проверяется и преобразуется в файл .PVA

5 PanelBuilder Software и терминал отображают статус загрузки

6 Терминал перезапускается, осуществляет проверку и отображает экран запуска приложения

Выделите Operator Terminal

Выделите Internal DF1 Driver

Показывает COM-порт, на котором
активизирован драйвер DF1

Введите имя файла .PVA, предназначенного для 
сохранения преобразованного файла .PBA, или 

щелкните Browse для поиска файла

Щелкните OK для
запуска загрузки

Кнопка Setup 
активизируется, если 
доступно более одного 
COM-порта

Пометьте эту опцию для загрузки приложения только в том случае, 
когда оно отлично от приложения, загруженного на терминал

Внутренний драйвер DF1 назначен COM2

При обнаружении ошибки или предупреждения открывается диалоговое окно Exceptions. Вы 
должны исправить ошибки перед тем, как загрузка может быть продолжена. Предупреждения 
следует исправить, но загрузка может быть продолжена и так

gtstart.pva
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Для загрузки приложения с использованием внутреннего драйвера DH485:

gtstart.pva

1 Откройте приложение, которое вы хотите загрузить

2 Выберите Download в меню Application

3 Выделите параметры Download

4 Приложение проверяется и конвертируется в файл .PVA

5 PanelBuilder Software и терминал отображают статус загрузки

6 Терминал перезапускается, осуществляет проверку и отображает экран запуска приложения

Выделите Operator Terminal

Выделите Internal DH485 Driver

Введите имя файла .PVA, предназначенного 
для сохранения преобразованного файла .PBA 

или щелкните Browse для поиска файла

Щелкните OK для 
запуска загрузки

Пометьте эту опцию для загрузки приложения 
только в том случае, когда оно отлично от 
приложения, загруженного на терминал

При обнаружении ошибки или предупреждения открывается 
диалоговое окно Exceptions. Вы должны исправить ошибки 
перед тем, как загрузка может быть продолжена. 
Предупреждения следует исправить, но загрузка может быть 
продолжена и так

Для терминалов DH-485 или RS-232 (DH-485) 
щелкните Setup для проверки сетевых параметров

Адрес узла терминала в сети

COM-порт, использующий 
внутренний драйвер DH485

Адрес узла компьютера в сети

Адрес узла самого высокого уровня в сети

Скорость 
передачи сети 

DH-485

Имя сети 
DH-485
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Закрытие приложения

Теперь вы можете закрыть приложение (GTSTART.PBA).

Для закрытия приложения:

В меню File выберите Close.

Или дважды щелкните окно меню управления окна файла приложения.

Для выхода из PanelBuilder:

В меню File выберите Exit.
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8 Запуск приложения

Задачи главы

Эта глава показывает, как запустить приложение на терминале PanelView 900. Она
содержит следующие разделы:

ëåäçàÐ .ðòÑ

åìèæåðìîêñå÷èòàìîòâàâÿëåòàãèâäêñóïàÇ 1-8

åìèæåðìîí÷óðâÿëåòàãèâäêñóïàÇ 3-8

Запуск двигателя в автоматическом режиме

Этот раздел показывает, как управлять двигателем в автоматическом режиме. В
автоматическом режиме двигатель управляется SLC или PLC и постоянно изменяет
скорость. Все клавиши, которые нажимаются в приведенном далее алгоритме,
расположены на терминале PanelView.

После загрузки приложения терминал PanelView отображает экран Motor Status.

Индикаторы Motor Status показывают, что двигатель запущен и находится в режиме
Auto.

Для контроля статуса двигателя в автоматическом режиме:

1. Нажмите клавишу F2  для останова двигателя.

Или, если терминал имеет сенсорный экран, нажмите 
STOP

MOTOR  .

Обратите внимание, как кнопки Start и Stop изменяют свой вид, чтобы показать
изменение состояния.

START
MOTOR

F1

MOTOR
STOPPED

Индикатор Status в окне Motor Status также показывает текущий статус двигателя.
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2. Нажмите клавишу F1  для повторного запуска двигателя.

Или, если терминал имеет сенсорный экран, нажмите 
START
MOTOR  .

3. Нажмите клавишу F8  для отображения экрана Motor Speed.

Или, если терминал имеет сенсорный экран, нажмите 
MOTOR
SPEED  .

В режиме Auto скорость двигателя постоянно изменяется и отображается
столбиковой диаграммой и дисплеем числовых данных.

900
900

Вы не можете вводить новую скорость или увеличивать / уменьшать скорость
двигателя в автоматическом режиме.

4. Нажмите клавишу F8  для возврата к экрану Motor Status.

Или, если терминал имеет сенсорный экран, нажмите 
MOTOR
STATUS  .

Сообщения сигналов тревоги не инициализируются в автоматическом режиме.
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Запуск двигателя в ручном режиме

Этот раздел показывает, как осуществлять управление и контроль двигателя в ручном
режиме. . Все клавиши, которые нажимаются в приведенном далее алгоритме,
расположены на терминале PanelView.

Для контроля статуса двигателя в ручном режиме:

1. Нажмите  , а затем  для выделения Manual в списке управления Select
Mode.

Или, если терминал имеет сенсорный экран, нажмите эквивалентные клавиши
списка справа от списка управления.

Индикатор Mode показывает, что двигатель в режиме Manual.

2. Нажмите клавишу F8  для возврата к экрану Motor Speed.

Или, если терминал имеет сенсорный экран, нажмите 
MOTOR
SPEED  .

Экран покажет текущую скорость двигателя.

100
100

В ручном режиме вы можете вводить новую скорость двигателя, увеличивать или
уменьшать скорость двигателя. Столбиковая диаграмма и дисплей числовых
данных автоматически обновляются для отражения изменений скорости.

3. Нажмите  для открытия блокнота.

Или, если терминал имеет сенсорный экран, нажмите объект Enter Speed для
открытия блокнота сенсорного экрана.
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4. Введите в блокноте значение 500 и нажмите  .

Объекты автоматически обновляются для отражения новой скорости.

500
500

5. Нажмите клавишу F1  для увеличения скорости двигателя.

Или, если терминал имеет сенсорный экран, нажмите INC  SPD  .

Объекты обновляются для отражения новой скорости.

6. Нажмите клавишу F1  дважды для повторного увеличения скорости.

Или нажмите F1  , чтобы увеличить скорость на 20 об./мин.

7. Нажмите клавишу F2  , чтобы уменьшить скорость на 30 об./мин.

Или, если терминал имеет сенсорный экран, нажмите DEC  SPD  .

Объекты автоматически обновляются для отражения новой скорости.

Следующие сигналы тревоги инициализируются в ручном режиме.

• MOTOR SPEED TOO HIGH, когда скорость двигателя больше, чем 950 об./мин.

• MOTOR SPEED TOO LOW, когда скорость двигателя меньше, чем 50 об./мин.
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A Программа релейно-контактной логики SLC
для приложения DH-485/DH+

Приложение PanelView Getting Started для SLC DH485/DH+

Программный листинг, файл: GETSTRTD.ACH

Звено 2:0

Таймер для увеличения и уменьшения скорости двигателя в автоматическом режиме.

Звено 2:1

Двигатель запускается при нажатии кнопки Start на PanelView. Статус запуска показывается посредством B3:0/4.

Звено 2:2

Двигатель останавливается при нажатии кнопки Stop на PanelView. Статус останова показывается посредством
B3:0/5.

Звено 2:3

Триггерный бит (B3:0/6) устанавливается при инкременте счетчика C5:0. Это вызывает уменьшение скорости
двигателя, если выделен автоматический режим.

Звено 2:4

Триггерный бит (B3:0/6) сбрасывается при нулевом значении счетчика C5:0. Это вызывает увеличение скорости
двигателя, если выделен автоматический режим.
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Звено 2:5

Счетчик C5:0 показывает скорость двигателя. Если выделен автоматический режим и двигатель запущен, будет
происходить инкремент этого счетчика.

Звено 2:6

Счетчик C5:0 показывает скорость двигателя. Если выделен автоматический режим и двигатель запущен, будет
происходить декремент этого счетчика.

Звено 2:7

В автоматическом режиме (N7:0=0) cкорость двигателя масштабируется значением 50 и сохраняется по адресу
N7:1.

Звено 2:8

В ручном режиме (N7:0=1) введенная оператором скорость двигателя, показываемая N7:1, масштабируется и
сохраняется в C5:0.

Звено 2:9

Таймер, используемый для увеличения и уменьшения скорости двигателя в ручном режиме.
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Звено 2:10

Когда двигатель запущен, скорость двигателя переносится в N7:2. PanelView отображает значение в N7:2.

Звено 2:11

Когда двигатель остановлен, величина "0" переносится в N7:2. PanelView отображает значение в N7:2.

Звено 2:12

Скорость двигателя увеличивается на величину=10, если нажата кнопка увеличения, выделен ручной режим и
двигатель запущен.

Звено 2:13

Скорость двигателя уменьшается на величину=10, если нажата кнопка уменьшения, выделен ручной режим и
двигатель запущен.

Звено 2:14
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Звено 2:15

Звено 2:16

Звено 2:17
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B Программа релейно-контактной логики PLC
для приложения Remote I/O

Программный листинг для RIO, PLC-5/25, файл: GSRIO1

Звено 2:0

Выходные данные блочной передачи для PanelView.

Звено 2:1

Входные данные блочной передачи для PV.

Звено 2:2

При нажатии кнопки запуска двигателя устанавливается индикатор запуска двигателя
и сбрасывается индикатор останова двигателя.

Звено 2:3

При нажатии кнопки останова двигателя устанавливается индикатор останова
двигателя и сбрасывается индикатор запуска двигателя.
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Звено 2:4

В автоматическом режиме N7:10 равно 0.

В ручном режиме N7:10 равно 1.

Звено 2:5

В автоматическом режиме N7:10 равно 0.

В ручном режиме N7:10 равно 1.

Звено 2:6

Таймер для увеличения и уменьшения скорости двигателя в автоматическом режиме.

Звено 2:7

Триггерный бит (B3:0/3=1) используется для уменьшения скорости двигателя в
автоматическом режиме.

Звено 2:8

Триггерный бит (B3:0/3=0) используется для увеличения скорости двигателя в
автоматическом режиме.
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Звено 2:9

В автоматическом режиме скорость двигателя будет постоянно увеличиваться и
уменьшаться в диапазоне от нуля до одной тысячи.

Звено 2:10

В ручном режиме скорость двигателя увеличивается на величину=10 каждый раз при
нажатии кнопки увеличения скорости двигателя.

Звено 2:11

В ручном режиме скорость двигателя уменьшается на величину=10 каждый раз при
нажатии кнопки уменьшения скорости двигателя.
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Звено 2:12

Когда бит уведомления скорости двигателя установлен, включается бит квитирования
и индикация отображения скорости двигателя.

Звено 2:13

Звено 2:14

Звено 2:15
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Звено 2:16

Звено 2:17

Звено 2:18
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C Программа релейно-контактной логики PLC
для приложения DH+

Программный листинг, файл: GSDHP.AF5

Звено 2:0

Таймер для увеличения и уменьшения скорости двигателя в автоматическом режиме.

Звено 2:1

Двигатель запускается при нажатии кнопки Start на PanelView. Статус запуска
показывается посредством B3:0/4.

Звено 2:2

Двигатель останавливается при нажатии кнопки Stop на PanelView. Статус останова
показывается посредством B3:0/5.

Звено 2:3

Триггерный бит (B3:0/6) устанавливается при достижении счета C5:0. Это вызывает
увеличение скорости двигателя, если выделен автоматический режим.

Звено 2:4

Триггерный бит (B3:0/6) сбрасывается при обнулении счетчика C5:0. Это вызывает
увеличение скорости двигателя, если выделен автоматический режим.

Звено 2:5

Счетчик C5:0 определяет скорость двигателя. Если выделен автоматический режим и
двигатель запущен, будет происходить инкремент этого счетчика.
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Звено 2:6

Счетчик C5:0 показывает скорость двигателя. Если выделен автоматический режим и
двигатель запущен, будет происходить декремент этого счетчика.

Звено 2:7

Скорость двигателя масштабируется значением 50 и сохраняется по адресу N7:1 в
автоматическом режиме.

Звено 2:8

Введенная оператором скорость двигателя, показываемая N7:1, масштабируется и
сохраняется в C5:0 в ручном режиме.

Звено 2:9

Таймер, используемый для увеличения и уменьшения скорости двигателя в ручном
режиме.

Звено 2:10

Когда двигатель запущен, скорость двигателя переносится в N7:2. PanelView
отображает значение в N7:2.

Звено 2:11

Когда двигатель остановлен, скорость двигателя переносится в N7:2. PanelView
отображает значение в N7:2.
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Звено 2:12

Скорость двигателя увеличивается на значение 10, если нажата кнопка инкремента,
выделен ручной режим и двигатель запущен.

Звено 2:13

Скорость двигателя уменьшается на значение 10, если нажата кнопка декремента,
выделен ручной режим и двигатель запущен.

Звено 2:14

Звено 2:15

Звено 2:16

Звено 2:17
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Tool Bar (панель инструментов)

Format Bar (панель форматирования) в Object View (режиме просмотра объекта)

Format Bar (панель форматирования) в Text View (режиме просмотра текста)

Format Bar (панель форматирования) в Graphics View (режиме просмотра графики)

Rockwell Automation помогает своим клиентам получать наивысшие прибыли от их инвестиций 
благодаря комплексному использованию ведущих марок промышленной автоматики и созданию 
широкого спектра легко интегрируемых продуктов. Это достигается благодаря повсеместно 
доступным локальным техническим средствам, глобальной сети поставщиков системных решений и 
дополнительных технических средств Rockwell.
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